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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

Class B Declaration of Conformity

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy 
and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded 
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the 
approval of manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice

This Class B digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe B de l’Industrie Canada 

Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.

Certificate by Manufacturer/Importer

This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been 
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.

Bescheinigung des Herstellers/Importeurs

Hiermit wird bescheinigt, dass der FC07 im Übereinstimmung mit den Bestimmungen der VFG 243/1991 funkentstört ist. Der Deutschen Bundespost wurde 
das Inverkehrbringen dieses Gerätes angezeigt und die Berechtigung zur Überprüfung der Serie auf Einhaltung der Bestimmungen eingeräumt.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstörbestimmungen 
geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen bei anderen Gerätekombinationen nicht eingehalten werden. 
Für die Einhaltung der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung richtiger Ausführungen ist der 
Betreiber verantwortlich.

Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE 
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT 
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE. 



                
License

EFI grants you a non-exclusive license to use the software (“Software”) and accompanying documentation (“Documentation”) included with the Product. The 
Software is licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend 
the Software. You may, however, permanently transfer all of your rights under this Agreement to another person or legal entity provided that: (1) you transfer to 
the person or entity all of the Software and Documentation (including all copies, updates, upgrades, prior versions, component parts, the media and printed 
materials, and this Agreement); (2) you retain no copies of the Software and Documentation, including copies stored on a computer; and (3) the recipient agrees 
to the terms and conditions of this Agreement. 

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except as necessary for backup or archive purposes in 
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to alter, disassemble, decompiler, decrypt 
or reverse engineer the Software.

Proprietary Rights

You acknowledge that the Software is proprietary to EFI and its suppliers and that title and other intellectual property rights therein remain with EFI and its 
suppliers. Except as stated above, this Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), 
or any other rights, franchises or licenses in respect of the Software. You may not adopt or use any trademark or trade name which is likely to be similar to or 
confusing with that of EFI or any of its suppliers or take any other action which impairs or reduces the trademark rights of EFI or its suppliers.

Confidentiality

You agree to hold the Software in confidence, disclosing the Software only to authorized users having a need to use the Software as permitted by this Agreement 
and to take all reasonable precautions to prevent disclosure to other parties.

Remedies and Termination

Unauthorized use, copying or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make available 
to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software and all of its component parts. All provisions of this Agreement 
relating to disclaimers of warranties, limitation of liability, remedies, damages, and EFI’s proprietary rights shall survive termination.

Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software 
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted or error free, or that all defects in the Software will be corrected. EFI makes no warranty, implied or 
otherwise, regarding the performance or reliability of any third party products (software or hardware) not provided by EFI. THE INSTALLATION OF ANY 
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION, 
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, EFI MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE 
SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, 
AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE OR NONINFRINGEMENT OF THIRD PARTY RIGHTS. 

Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software in any form in violation of any applicable laws or regulations of the United States or the country in 
which you obtained them.

U.S. Government Restricted Rights:

The Software and Documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the United States Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) 
and (2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as applicable.



  
General

The laws of the State of California govern this Agreement. You agree that this Agreement shall not be subject to the United Nations Convention on Contracts for 
the International Sale of Goods (1980). This Agreement is the entire agreement held between us and supersedes any other communications or advertising with 
respect to the Software. If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions, please see EFI’s web site at www.efi.com.

Electronics For Imaging
303 Velocity Way
Foster City, CA 94404
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xi About this manual

             
The Fiery 3850C™ is a special-purpose controller board built into the printer. It 
enables you to use your printer as a high-speed networked color printer.

This manual is intended for Fiery 3850C operators or administrators, or users with the 
necessary access privileges, who monitor and manage job flow and troubleshoot 
problems that may arise. It describes the functions and features of Fiery™ utilities and 
Fiery WebTools™ for the purposes of print job management and color quality control.

Although it may not be the case at all sites, the documentation for this product 
assumes the presence of an operator who controls and manages jobs sent by users from 
remote workstations.

NOTE: The term “Fiery 3850C” is used in this manual to refer to the printer in which 
the Fiery 3850C is embedded. The name “Aero” is used in illustrations to represent the 
Fiery 3850C.

About this manual
This manual is organized as follows:

• Chapter 1 describes the Fiery 3850C Control Panel. It explains the various messages 
and icons that you might see and describes how to print system information pages. It 
also explains how to properly start up and shut down the Fiery 3850C.

• Chapters 2 and 3 describe the Command WorkStation interface. The Command 
WorkStation application can be installed on networked Windows computers and 
used to view and manage virtually all aspects of Fiery 3850C activity. In addition to 
providing a graphic display of the job flow, the Command WorkStation allows you 
to reprint or hold jobs, view and override print option settings, download files, 
manage printer fonts, preview print jobs, calibrate the Fiery 3850C, and perform 
Setup (server configuration). The Command WorkStation also provides tools for 
archiving jobs and moving jobs between Fiery 3850C printers.

• Chapter 4 introduces Fiery WebTools, explains how to access them, and directs you 
to sources of more information (in this manual or in other manuals in the 
documentation set).

Preface
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• Chapter 5 describes Fiery WebSpooler, which can be used to view and manage Fiery 
3850C job activity. The interface and features of Fiery WebSpooler have identical 
counterparts in the Command WorkStation; therefore, this chapter refers you to 
Chapters 2 and 3 for details about Fiery WebSpooler.

• Appendix A lists error messages that you might see on the Fiery 3850C Control 
Panel, the Command WorkStation, Fiery WebSpooler, or the printer, and contains 
some troubleshooting information.

Terminology
Specific terms are explained as they are introduced. However, the following general 
terms are used throughout:

• PostScript (PS)—A computer language designed as a page description language. 
The Fiery 3850C uses this language for imaging the page and for communication 
with applications and with the print engine.

• Printer Control Language (PCL)—A computer language designed as a page 
description language. The Fiery 3850C uses this language for imaging the page and 
for communication with applications and with the print engine.

• Job—A file consisting of PostScript or PCL commands and comments that describe 
the graphics, sampled images, and text that should appear on each page of a 
document, and the printer options that should be used in printing, such as media or 
color rendering style. The postscript or PCL files described include PDF files.

• Spool—Write to a disk. Usually used here to refer to a PostScript or PCL print job 
being saved to the Fiery 3850C hard disk in preparation for processing and printing.

• RIP—Acronym for raster image processing, which changes text and graphics 
commands into descriptions of each mark on a page. In common use as a noun, a 
“raster image processor” (RIP) is the computer processor that performs this function.

• Print—The process of rendering, or imaging, a page or a job on a printer.

These concepts can explain how the Fiery 3850C and the printer work together as a 
powerful printing system. The Fiery 3850C RIP changes text and graphics commands 
in PostScript or PCL into color specifications for each dot of toner deposited on a page 
by the printer.



 

xiii About the documentation

              
About the documentation
This manual is part of the set of Fiery 3850C documentation, which includes the 
following manuals for users and system administrators:

• The Configuration Guide explains basic configuration and administration of the 
Fiery 3850C for the supported platforms and network environments. It also 
includes guidelines for setting up UNIX, Windows 2000, Windows NT 4.0, and 
Novell NetWare servers to provide PostScript or PCL printing services to clients.

• Getting Started describes how to install software to enable users to print to the Fiery 
3850C. Specifically, it describes installation of PostScript or PCL printer drivers, 
printer description files, and other user software provided on the User Software CD 
and Command WorkStation CD. It also explains how to connect each user to the 
network.

• The Printing Guide describes the printing features of the Fiery 3850C for users who 
send jobs via remote workstations on the network or via a direct parallel port 
connection.

• The Color Guide provides an introduction to the basics of color theory and printing 
to a Fiery 3850C printer. It also includes practical color printing tips and application 
notes that explain how to print to the Fiery 3850C from popular Windows and Mac 
OS applications.

• The Job Management Guide explains the functions of the Fiery 3850C client utilities, 
including the Command WorkStation, and how they can be used to manage jobs 
and maintain color quality. This book is intended for an operator or administrator, 
or a user with the necessary access privileges, who needs to monitor and manage job 
flow, perform color calibration, and troubleshoot problems that may arise.

• Release Notes provide last-minute product information and workarounds for some of 
the problems you may encounter.
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Fiery 3850C job environments
The Fiery 3850C supports several levels of control of printing, job management, and 
setup, and offers you the flexibility to choose the configuration that corresponds to the 
requirements of your site. Your situation may correspond to one of the descriptions 
outlined in the following section, or you may prefer an intermediate level of control.

At one extreme, an administrator or operator in a high-volume printing environment 
controls the entire job flow and all printing. Print jobs arriving from remote users are 
spooled to the server disk and stored until the operator decides it is time to print them. 
Additional functions (calibration, job overrides, prioritizing, font management) are 
reserved for the administrator or operator.

At the other extreme, anyone on the local network can control all printing and 
server functions; operator intervention is not necessary. Users can print from their 
workstations to any of the published print connections. Anyone can use the Command 
WorkStation or Fiery WebSpooler to control any print job.

The spectrum of control that an administrator can implement is described in the 
Configuration Guide.

Permissions
Support for these job environments is achieved by a combination of Fiery 3850C 
Setup options. By default, anyone can access Setup, but the administrator can limit 
access to Setup by specifying an Administrator password for the Fiery 3850C (see the 
Configuration Guide).

Also by default, anyone can log in to the Command WorkStation or Fiery WebSpooler 
and control job flow, but an administrator can restrict access to these functions by 
specifying an Operator password.
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The three security levels from greatest to least control are:

• Administrator—confers control of Setup and is the highest level of control. The 
person who has access to Setup can control the printing and job management 
environment by enabling print connections and setting passwords. The 
Administrator can also manage the fonts on the server, clear the server disk when 
necessary, and set a common web link for all users who log in to the Fiery 3850C 
using their web browser. 

• Operator—includes control of print jobs that arrive at the server and the ability to 
perform calibration and reboot the server.

• Guest—allows users to view the status of active jobs and the list of stored jobs. They 
cannot make changes to jobs or change their printing instructions. A password is not 
needed to log in as Guest and view jobs from the Command WorkStation, or Fiery 
WebSpooler windows.

This manual describes the features of the Fiery client utilities, including the Command 
WorkStation, and all operator privileges, whether those privileges are available to 
everyone or are exclusive to only certain people. It also includes descriptions of 
administrator functions and provides references to other manuals for more 
information.
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1-1 Using the Control Panel

    
You can use the Control Panel on the printer to access all basic functions of the Fiery 
3850C, access special features, view status and information about jobs printed to the 
Fiery 3850C, view printer error messages, print system pages, run diagnostics, and 
configure Fiery 3850C Setup options. For information about Setup options and how 
to use them, see the Configuration Guide.

Using the Control Panel

Chapter 1:
Operating the 
Fiery 3850C

On Line Menu

Ready

Cancel
Data InErrorPower

# Enter

 

Display window

Navigation buttons

On Line button

Menu button

Enter button

Cancel button

Activity lights
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1-2 Operating the Fiery 3850C

 

The parts of the Control Panel that control functionality of the Fiery 3850C are:

Menu button Menu button—Enters the Functions menus. From a 
Setup menu option, returns to the previous Setup 
menu. 

Activity lights Online light/Online Button—puts the Fiery 3850C 
online or offline.
Light off—The Fiery 3850C is offline or the power is 
off.
Solid green—The Fiery 3850C is online.

Power light
Off—The power is off.
Solid green—Indicates normal state.
Blinking green—The Fiery 3850C is warming up. 

Error light
Blinking red—An error has occurred that may not 
interfere with printing. The Fiery 3850C requires 
attention. 
Solid red—

Data in light
Blinking green—The Fiery 3850C is spooling or 
RIPping a job. 

Navigation buttons Up arrow—In Setup menus, advances from one 
menu to the next. When entering numbers or text, 
increment to the previous number or character. 

Down arrow—In Setup menus, advances from one 
menu to the previous. When entering numbers or 
text, decrements to the next number or character. 

Right arrow—Advances the cursor to the text-entry 
position to the right.

Left arrow—When entering numbers or text, 
backspaces and deletes.
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Control Panel Fiery 3850C status messages
When the Fiery 3850C has control of the Control Panel, the LCD provides 
information about the current status of the Fiery 3850C.

Control Panel Fiery 3850C status messages are:

Enter button Activates the currently selected option and, if 
applicable, proceeds to the next menu. 

While RIPping, Enter stops printing or processing 
the current job after the printer has finished printing 
the current page. 

If the correct page size is unavailable for the current 
job, Enter forces the Fiery 3850C to print the job on 
the default paper size. 

Cancel button In Setup menus, exits menus entirely, returning to 
Info. 

While printing, Cancel stops printing the current 
job. 

Ready The Fiery 3850C is in a normal state, ready to print.

<Message>
(Error light 
blinking)

Displays a warning message. An error has occurred that may 
not interfere with printing. The Fiery 3850C requires 
attention. 

<Message>
(Error light solid)

Displays an error message. An error has occurred that 
prevents printing.

Processing Appears when the Fiery 3850C is processing a job. The 
activity light flashes green.

Printing 
<Job Name>

Appears when the Fiery 3850C is printing a page from the 
Print menu. Job Name indicates the type of special page. 
The activity light flashes green.

Printing Appears when the Fiery 3850C is printing a job. The 
activity light flashes green.
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NOTE: If the Fiery 3850C is idle for more than the default time of two minutes, control 
of the Control Panel returns to the printer. Press the Menu button to return control to 
the Fiery 3850C. 

<User Name>
Copies: #C/#T

Appears when the Fiery 3850C is printing a job. #C 
indicates the copy currently printing; #T indicates the total 
number of copies in the job. The activity light flashes green.

Canceling Appears when the Cancel button has been pressed and the 
currently printing or processing job is being canceled.
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Press the Menu key to display the Functions menu. The following options are 
available:

Check and Print Select to view pending jobs. Scroll through the list of 
pending jobs with the up and down arrow keys. Press the 
Enter button to print the selected job.:

Secure Print Select to view pending secure print jobs.:

Print Menu Select to print system pages from the Fiery 3850C. Scroll 
through the submenu with the up and down arrow buttons. 
Press the Enter button to print the selected page. 

Print Config Page
Gives the current Fiery 3850C and device configuration. 
This page lists general information about the hardware and 
software configuration of the Fiery 3850C, the current 
options for all Setup settings, information about the current 
calibration, and if applicable, the Ethernet and Token Ring 
addresses of the Fiery 3850C.

Print Job Log
A list of the last 55 print jobs. For information on the fields 
in the Job Log and on printing it in other forms, see 
page 2-30.

Print PCL Font List 
A list of all PCL fonts resident on the Fiery 3850C hard 
disk.

Print PS Font List
A list of all PostScript fonts resident on the Fiery 3850C 
hard disk.

Print Test Page
Enables you to confirm that the Fiery 3850C is properly 
connected to the printer. The Test Page provides sample 
images and color samples. The following information is 
also listed: Server name, Printer model, color settings, 
calibration information, and date and time printed.

Tray Setup Menu Accesses Tray Setup menus. Use these menus to set the size, 
paper type, and locking for each installed paper tray.
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Resets Select reset system values on the Fiery 3850C. 

Clear Log/Queues
Select Yes or No with the up and down arrow buttons. Press 
Enter to enact your selection.

Clear Fonts
Select Yes or No with the up and down arrow buttons. Press 
Enter to enact your selection.

Reset Color
Select Yes or No with the up and down arrow buttons. Press 
Enter to enact your selection.

Restore Defaults
Select Yes or No with the up and down arrow buttons. Press 
Enter to enact your selection.

Restart Printer
Select Yes or No with the up and down arrow buttons. Press 
Enter to enact your selection.

System Setup Accesses the system setup menus

Printer Name
Use the up and down arrow buttons to select the character 
for each space. Use the left and right arrow buttons to move 
the cursor left or right.

Publish Printed Q
Select Yes or No with the up and down arrow buttons. Press 
Enter to enact your selection.

Jobs to Save
Use the up and down arrow buttons to select the number of 
jobs to save.

Energy Saver 1
Select On or Off with the up and down arrow buttons. 
Press Enter to enact your selection.

Energy Saver 2
Select On or Off with the up and down arrow buttons. 
Press Enter to enact your selection.
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E. Saver 2 Timer
Select a number of minutes with the up and down arrow 
buttons. Press Enter to enact your selection.

Time
Use the up and down arrow buttons to select the number 
for each space. Use the left and right arrow buttons to move 
the cursor left or right.

Date
Use the up and down arrow buttons to select the number 
for each space. Use the left and right arrow buttons to move 
the cursor left or right.

Change Password
Select Yes or No with the up and down arrow buttons. Press 
Enter to enact your selection. 
If you select Yes, Enter the old password and then enter and 
confirm the new password: Use the up and down arrow 
buttons to select the character for each space. Use the left 
and right arrow buttons to move the cursor left or right. 
Press Enter to confirm your entry. 

Printer Setup Accesses the printer setup menus

Page Desc Lang
Use the up and down arrow buttons to select Auto, PCL, or 
PS. 

Default Paper
Use the up and down arrow buttons to select a paper size. 

Auto Continue
Use the up and down arrow buttons to select On or Off.

Def Output Tray
Use the up and down arrow buttons to select a tray.

Job Separations 
Use the up and down arrow buttons to select On or Off.

B&W Page Detect
Use the up and down arrow buttons to select On or Off.
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Hex Dump Mode
Use the up and down arrow buttons to select On or Off.

PS Setup Accesses the PostScript setup menus

Error Page
Use the up and down arrow buttons to select Yes or No.

Def Resolution
Use the up and down arrow buttons to select a resolution. 

PCL Setup Accesses the PCL setup menus

Orientation
Use the up and down arrow buttons to select Portrait or 
Landscape. 

Form Length
Use the up and down arrow buttons to select a number of 
lines. 

Font Number
Use the up and down arrow buttons to select the number of 
fonts, from 0 to 45.

Pitch
Use the up and down arrow buttons to select a size.

Symbol Set
Use the up and down arrow buttons to select the symbol 
set.

Memory Overflow
Use the up and down arrow buttons to select Yes or No.

Colorwise Setup Accesses the Colorwise setup menus

Source Profile
Use the up and down arrow buttons to select a profile. 

Rendering Style
Use the up and down arrow buttons to select a style. 

CMYK Sim Profile
Use the up and down arrow buttons to select a simulation 
profile.
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Spot Color Match
Use the up and down arrow buttons to select On or Off.

Pure Black Text
Use the up and down arrow buttons to select On or Off.

Black Overprint
Use the up and down arrow buttons to select On or Off.

Visual Cal Starts the Calibration process. When you see the message 
Printer Warning, use the up and down arrow buttons to 
select Abort Calib or Start Calib. Visual Cal may requires a 
password.

I/O Port Setup Accesses the Input/Output port setup menus

Ethernet
Use the up and down arrow buttons to select a On or Off. 

Speed
Use the up and down arrow buttons to select a the network 
connection speed, autodetect, 100, or 10. 

Parallel Port
Use the up and down arrow buttons to select On or Off.

Port Timeout
Use the up and down arrow buttons to select a number of 
seconds.
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Restarting the Fiery 3850C
Generally, you can leave the Fiery 3850C and the printer running all the time. This 
section describes how to restart when necessary.

Turning the printer off
Use the procedure below to turn off power to the printer.

TO TURN OFF POWER TO THE PRINTER:

1. Make sure the Online button light is steady and unblinking.

If the button light is blinking, wait until all jobs have finished printing, and proceed 
when the light becomes steady.

2. Press the main power switch on the printer.

The power switch is located on the front panel, to the left of the top paper tray.

Restarting the Fiery 3850C
When you restart the Fiery 3850C, fonts that have been downloaded to the hard disk 
drive are not deleted. Print jobs in the Hold queue, the Printed queue, and jobs that 
have been processed but not printed are not deleted; they will be available for printing 
when you restart the Fiery 3850C.

TO RESTART THE FIERY 3850C:

1. When the Control Panel reads READY, press the Menu button to access the Resets 
menu. 

When you restart the printer, make sure that the Fiery 3850C Control Panel reads 
READY. If the printer is turned off during RIPping/Printing, this may cause Fiery 
3850C hard disk damages.

2. Use the Down arrow button to scroll to Restart Printer. Press the Enter button. 
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This chapter introduces you to the graphical user interface of Command WorkStation. 
Select a user level and log in to the Fiery 3850C. Once you have logged in, you can 
tour the Command WorkStation windows. Your exploration will be more complete if 
you have some jobs in the Spool area (jobs printed to the Hold queue) and have the 
ability to send more jobs from a nearby computer.

Chapter 3 builds on the information in this chapter and describes job monitoring and 
control in more depth. 

About Command WorkStation
Command WorkStation provides a window on Fiery 3850C and printer functions, 
and an interface from which you can control those functions. The Command 
WorkStation application can be installed on a Windows computer with a TCP/IP or 
IPX network connection to the Fiery 3850C.

By default, no passwords are set on the Fiery 3850C—in this default state, anyone can 
perform Setup and use all Command WorkStation functions. Until Administrator and 
Operator passwords are defined in Fiery 3850C Setup, you can log in to Command 
WorkStation as an Administrator without entering a password, and you are given full 
privileges. For information about Setup and specifying passwords, see the 
Configuration Guide.

Chapter 2:
Introduction 
to Command 
WorkStation
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After the Administrator has performed Setup and specified passwords, Command 
WorkStation user options depend on your login level. If you log in to the Command 
WorkStation as Guest, you have only the first option listed below. If you log in as 
Operator, you have the first two options. If you log in as Administrator, you have all 
four options.

Command WorkStation privileges include the following:

• A view of current printing jobs and jobs stored on the Fiery 3850C (Guest, 
Operator, Administrator)

• Control of printing jobs (Operator, Administrator)

• Ability to perform calibration (Administrator)

• Access to Setup, management of resident fonts, clearing of the Fiery 3850C disk and 
the Job Log (Administrator)

After you connect to a Fiery 3850C and log in, your first view of the Command 
WorkStation is the Queues window (as indicated by the tab at the bottom) which is 
divided into three regions by Spool, RIP, and Print status bars. The Queues window is 
surrounded by a frame that includes slider buttons and menus.

Once the Fiery 3850C receives print jobs, the Queues window becomes a dynamic 
display, filled with the names of jobs and their characteristics. Status bars animate in 
real time as new jobs are processed and printed, and jobs move to different display 
areas. An operator, who has complete job control, sets the process in motion for each 
job.

The Spool, RIP, and Print areas of the Queues window represent the stages of printing 
a job. Jobs come in at the top level (Spool) and drop down to the Print level, unless 
they are held along the way.

• Spooled jobs—Jobs listed below the Spool status bar area are PostScript or PCL files 
stored on the Fiery 3850C disk. These jobs were sent to either the Print queue 
(white printer icons) or the Hold queue (yellow icons). 
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• RIPped jobs—Jobs listed below the RIP status bar are ready to print. They have 
already been rasterized (RIPped, or processed for printing) and are waiting, in order, 
for access to the printer. Rasterized jobs can also be held; held jobs are displayed on a 
yellow background.

• Printed jobs—Jobs listed below the Print status bar have already been printed. 
Printed jobs can be stored on the Fiery 3850C disk. The number of jobs that can be 
stored (from 1 to 99) is defined in Setup.
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You can interact with jobs in the window by selecting them and choosing from Job 
menu commands or right-mouse menu commands, or by double-clicking them. 
(However, if passwords have been set and you log in as Guest, you can only view jobs; 
you cannot change or route them.) This chapter and the next explain the Command 
WorkStation interface in detail.

Starting up and logging in
To start up the Command WorkStation application, click the Windows Start button 
and choose Command WorkStation from the Programs menu; or, if you have created a 
shortcut to the Command WorkStation application, double-click the Command 
WorkStation icon.

Connecting to the Fiery 3850C
If the Command WorkStation was previously connected to the Fiery 3850C, you are 
prompted to choose it from a list of servers.

If Command WorkStation has never been connected to the Fiery 3850C, you 
are prompted to configure a new entry. Click OK and see Getting Started for 
instructions on how to configure a new connection.

NOTE: Connection information must be specified using TCP/IP, and the device name 
“3850C” used specifically.

With the Fiery 3850C device name selected, click OK. If the device name is not 
displayed, click the plus sign (+) to expand the Fiery 3850C entry.
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The Command WorkStation connects to the Fiery 3850C and you are prompted to 
choose a login level and enter a password to log in (see below). If you have any 
difficulties connecting to the Fiery 3850C, see Appendix A for error messages and 
troubleshooting information.

Logging in
When the Command WorkStation has connected to the Fiery 3850C, the log in/out 
slider appears, prompting you to select a login level and enter a password. Before you 
log in, the Administrator key is in the vertical position, and the Operator, 
Administrator, and Guest keys are in the flat (horizontal) position. When you click 
your login level, the corresponding key turns to the vertical position.

For Administrator or Operator access to the Fiery 3850C, click the corresponding key, 
enter the password, and click Log in or press Enter. For Guest access only, click the 
Guest key and then click Log in. No password is required for Guest access.

If you change your mind about logging in, or do not have the password you need, click 
Cancel.

If you forget your Administrator password, contact your authorized service 
representative. 

Log in/out slider
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When you have entered the appropriate password and logged in, the log in/out slider 
retracts and the full Command WorkStation display appears. The color of the key in 
the lock indicates your login level. If the Fiery 3850C is handling a large number of 
jobs, it may take a few moments to display the entire job list.

When you reopen the slider after you have logged in, the Log in button will have 
changed to the Log out button.

Access levels

The three possible levels of access to Command WorkStation functions are 
Administrator, Operator, and Guest. To enable maximum password protection, 
Administrator and Operator passwords must be specified in Setup (see the 
Configuration Guide).

When both Administrator and Operator passwords have been specified, the access 
levels are as follows:

NOTE: Access privileges alone do not confer control of print jobs. If the operator is 
going to manage all print jobs, the Administrator must route all user jobs to the Hold 
queue (that is, all jobs are spooled and held on the Fiery 3850C). To accomplish this, 
only the Hold queue, and not the Direct connection or the Print queue, should be 
enabled in Setup. See the Configuration Guide for more information.

Access level: Privileges and password requirements:

Administrator Has full access to all Command WorkStation and Control Panel 
functions; Administrator password required.

Operator Has access to all Command WorkStation functions except Setup, 
calibration, clearing the Fiery 3850C disk, clearing the Job Log, and 
font management; Operator password required.

Guest Can view job status, but cannot make changes to jobs or Setup, and 
can view the Queues window only; no password required.
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Logging out
There are two ways to log out from the Fiery 3850C:

• From the Server menu, choose Log out.

• Open the log in/out slider (click the key icon just below the Fiery logo) and click 
Log out.

The Command WorkStation interface
The display illustrated below is the default Command WorkStation display in the 
middle of job processing. It shows the elements common to all Command 
WorkStation displays (1 through 4) and the Queues window elements (5 through 8). 
There are two other windows, Archive and Job Log, which you access via tabs at the 
bottom of the display (3). However, the Queues window is the one from which most 
Command WorkStation operations are performed. The elements numbered 1 through 
4 are common to all Command WorkStation displays, those numbered 5 through 7 
appear only in the Queues window, and element number 8 is common to the Queues 
and Archive windows. 
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The Command WorkStation provides access to a great deal of information and many 
features that are accessed in various ways—buttons, menus, double-clicking, and 
right-mouse commands. It is a powerful interface that allows for a great deal of 
interaction and flexibility in the production process. This section describes each of the 
elements that compose the Command WorkStation display.

1 Server selection tabs

2 Sliders and system information

3 Window selection tabs

4 Job ticket information

5–7 Queues window display

8 Thumbnail A and B

1

2

3

4
5

6

7

8
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Window area (Queues, Archive, Job Log)
This area can display one of three windows: the Queues window (shown below), the 
Archive window, or the Job Log window (only the Queues window is available if you 
logged in as Guest). The Queues window is the default window; it shows spooled, 
processing, and printing jobs in a display that changes dynamically.
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Menu bar

The menu bar has six menus. When an action is not available in the current context, 
the command is dimmed.

For information on: See:

Queues area “Queues window” on page 2-17

Archive area “Archive window” on page 2-27

Job Log area “Job Log window” on page 2-30

Menu: Choose this: To do this:

File Preferences Set Command WorkStation preferences; see page 3-4.

Print Pages Print any or all of the following pages to the Fiery 3850C: 
Configuration page, Test Page, Help Map Font List, Color Charts, 
Job Log. You can also print the Configuration page to any printer 
you specify; see page 3-6.

Exit Log out from the Fiery 3850C, exit the Command WorkStation 
application, and return to the Windows desktop.
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Job 
(For more 
information 
on these 
commands, 
see page 2-24).

Delete Delete one or more selected jobs.

Duplicate Duplicate one or more selected PostScript data jobs in the Spool or 
Print areas; see page 2-21, page 2-23, and page 2-25.

Rename Rename a selected job.

Hold Hold the selected job(s); see page 2-19.

RIP and Hold RIP and then hold the selected job(s); see page 2-19.

Print Print the selected job(s); see page 2-23.

Print and Hold Print the selected job(s) and then hold it in the RIP area; see 
page 2-19.

Process Next Give top priority to this job (Spool area only).

Remove Raster Remove the raster information from the selected job(s); see 
page 2-25.

Properties View and edit print settings for the selected job(s) and print job(s) 
with new settings; see page 2-36.

Thumbnail A Open a selected held raster data job in the Thumbnail A window 
where you can view a full-screen preview of the job, edit the job, or 
merge it with raster data from other jobs; see page 2-38

Thumbnail B Open a selected raster data job (not necessarily a held job) in the 
Thumbnail B window for viewing a full-screen preview of the job, 
or for copying pages into a job in the Thumbnail A window; see 
page 2-38

Download Download files and fonts to the Fiery 3850C; see page 3-22. You 
can also choose this command by right-clicking on the Spool status 
bar.

Archive Archive one or more selected jobs; see page 2-27 and page 3-27.

Menu: Choose this: To do this:
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Page
(Job Merge 
and Edit 
commands for 
Thumbnail A)

Delete Delete the selected page(s)

Duplicate Duplicate the selected page(s)

Preview View a full-screen preview of the selected page; see page 2-40

Undo Undo previous Page menu commands (multiple undos available)

Server Cancel RIPping Stop RIPping the current job. You can also choose this command 
by right-clicking on the RIP status bar.

Cancel Printing Stop printing the current job. You can also choose this command by 
right-clicking on the Print status bar.

Manage Fonts View the fonts currently installed on the Fiery 3850C disk, 
download additional fonts, or delete fonts (requires Administrator 
privileges); see “Managing server fonts” on page 3-25.

Manage Color Start ColorWise Pro Tools; see the Color Guide.

Clear Job Log Clear all jobs from the Job Log (requires Administrator privileges); 
see “Other server management commands” on page 3-29.

Reboot Perform a soft reboot of the Fiery 3850C (requires Operator or 
Administrator privileges); see “Other server management 
commands” on page 3-29.

Clear Clear all jobs in all queues as well as all jobs archived on the Fiery 
3850C hard disk, the index of archived jobs, and the Job Log 
(requires Administrator privileges); see “Other server management 
commands” on page 3-29.

Setup Start the Fiery Setup program (requires Administrator privileges); 
see “Other server management commands” on page 3-29 and the 
Configuration Guide.

Log out Log out of the Fiery 3850C.

Menu: Choose this: To do this:
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Server selection tabs

The Server selection tabs, just below the menu bar at the top of the display, can be used 
to log in to additional Fiery 3850C servers and to switch between Fiery 3850C servers 
currently connected to the Command WorkStation.

If you click a blank tab, you are prompted to connect to a Fiery 3850C in the list or 
configure a new Fiery 3850C entry (see “Connecting to the Fiery 3850C” on 
page 2-4). A limit of five Fiery 3850C servers can be connected to a single Command 
WorkStation.

You can access the Server selection tabs from all Command WorkStation windows 
(Queues, Archive, and Job Log).

Window Filter Open the Filter dialog box for the active window; see page 2-31.

Export Save the information in the active window as a tab-delimited text 
file; see page 2-29 and page 2-31.

Print Print the active window.

View in Helper App Open the active window in a particular application you specify; see 
page 3-4.

Refresh Update the Job Log window with the latest information.

Revert to Default Settings Restore default settings for the status areas, the column headings, 
and the column widths.

Help About View the Command WorkStation information screen.

Menu: Choose this: To do this:
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Sliders
Along the left side of the display are buttons you click to activate function sliders.

To retract any slider, click the icon at the far right of the slider.

Server information slider

The Server information slider displays name and version information about the 
currently connected Fiery 3850C and the Command WorkStation. To retract the 
slider, click the Fiery logo at the far right of the bar.

Click to view Fiery 3850C 
information

Click to open the log in/out slider

Click to start a Fiery utility
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Log in/out slider

This slider is described in “Logging in” on page 2-5 and “Logging out” on page 2-7. To 
retract the slider, click the lock icon at the far right of the bar.

Utilities shortcut slider

This slider can be used to access the Fiery Downloader and ColorWise Pro Tools 
utilities. These utilities can also be accessed from the Job menu and Server menu, 
respectively. To retract the slider, click the icon at the far right of the bar.
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Job ticket information

All the jobs listed by name in the Queues and Archive windows can display the job 
ticket information specified by the person who originated the print job. The 
Command WorkStation can display this information because it parses the PostScript 
or PCL file before it is RIPped. 

You have considerable flexibility in arranging this information in the display. For 
example, you can add Media Type to the display if you want to see which jobs call for 
special paper or other media. 

You can choose not to display headers for options that are not used at your site, or you 
can display all possible options and scroll to see the ones that are less important to you. 
If you just want to experiment, when you are finished you can choose Default Settings 
from the Window menu.

For instructions on customizing the display in the Queues, and Archive windows, see 
page 3-3.

Window selection tabs

The Command WorkStation always starts out by displaying the Queues window, from 
which you view current job processes and control job flow and file storage. To go to 
another window, click the corresponding tab at the bottom of the Command 
WorkStation display.
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Queues window
The Queues window is a dynamic display of the job staging area: jobs are lined up for 
processing and printing, some of them are being held waiting for directions, some are 
moving from one stage or queue to another and are finally dropped from the list, some 
are held for processing by the operator, and some are held in a different queue in case 
you need to reprint them.

One approach to understanding the dynamic display is to imagine the three parts of 
the Queues window corresponding to the three stages of printing, illustrated as a 
downhill flow.

Spooling—a PostScript or PCL file is saved on the Fiery 3850C hard disk. The file can 
come in packets from the network, or from another place on the Fiery 3850C hard 
disk. Jobs are added to a queue in the order in which they arrive, and they generally 
move to another queue in the same order unless an operator has intervened to change 
the order. 

Rasterizing (RIPping)—PostScript or PCL commands are interpreted in the Fiery 
3850C to allow the printer to print the file the way its originator intended. The result 
of this interpretation is a raster file associated with the original PostScript or PCL file. 
In this raster file (raster image), color data is associated with each dot that can be 
rendered by the print engine. The color data tells the print engine whether or not to 
apply cyan, magenta, yellow, or black toner to each position on the page.

Printing—The raster image is transferred from the Fiery 3850C to the print the print 
engine at high speed, freeing up RAM for the next job. While the PostScript or PCL 
file is usually saved to disk, raster images are held in RAM during and after each print 
job. However, both users and operators can request that the Fiery 3850C save the 
raster image to disk along with the PostScript or PCL file.

Saving the raster image to disk offers some advantages—raster files are already 
processed so they print quickly, and each part of the raster file is still identified with a 
page in the original document, which means that individual pages of a saved raster file 
can be accessed.

Spooling

RIPping

Printing
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Status bars
Jobs actively involved in the three processes (spooling, rasterizing, and printing) are 
listed in the status bars that span the Queues window.

Status bars show the filename, and user name for the active process, and an indication 
of its progress. Each status bar heads the list of jobs that have completed the process. 
Thus, beneath the Spool status bar, you see a list of spooled files; beneath the RIP 
status bar, you see a list of rasterized (RIPped) files; beneath the Print status bar, you 
see a list of jobs that have already been printed.

NOTE: In the Spool status bar, the filename and user information always appear as 
“Unknown” (as shown below). This information is not available until the job has 
finished spooling to the Fiery 3850C disk.

When a job is being processed, provided animation is enabled (see page 3-4), the 
corresponding status bar is animated, indicating that the process is active. Each status 
bar lists the filename of the active job, the user name, and an indication of its size or 
progress.

If an error occurs, the Print status bar alerts you by displaying a message on a red 
background instead of the normal blue background. 

Spooled jobs on Hold (yellow)
Active spooled jobs (white)

RIPped jobs on Hold (yellow)
Active RIPped jobs (white)

Printed jobs (white); some include 
raster files in RAM
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Enlarging the status bars  Click the small arrows at the left of the status bar to 
expand the status bar display. Click the arrows again to collapse the status bar to its 
original size. To expand all the status bars at the same time, press Ctrl-E. To collapse 
them to their original size, click the arrows or press Ctrl-E again.

Changing proportions  By default, the status bars divide the window area into three 
equal parts. You can drag the RIP and Print status bars up or down to change the 
proportion of the window devoted to each job area. For example, drag the RIP status 
bar down if you have a long list of spooled jobs that you want to see without scrolling.

Making space  If your workflow includes holding many jobs, and you don’t want to 
view the held jobs all the time, consider moving some of them to the Archive window. 
You can move jobs back and forth between the Queues window and the Archive 
window with a single right-mouse command (see page 2-24).

Active jobs and held jobs

In the description that follows, assume that the operator has full control of jobs; that is, 
the administrator has disabled the Direct connection and the Print queue, and all user 
jobs come to the Hold queue. For more information about queues, see the 
Configuration Guide.
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The operator’s job management functions permit holding a job at any stage of the 
process we have described, as illustrated below. In the figure, boxes indicate types of job 
icons you would see in the Queues window. 

Spooled and held

RIPped and held

Print and hold

RIP

Print

Printed

PostScript, PCL, 
and raster data

Deleted

Spool

Spooled for printing

RIPped for printing

Print*

*A copy of the held job is printed; the held job remains in the RIP area.

PostScript and 
PCL data
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Jobs that are held are shown with a yellow icon in a yellow row, just beneath the Spool 
or RIP status bar. Jobs that are held must be activated with a command in order to 
print.

Active jobs are shown in white with white icons; new jobs are added above older jobs.

Job icons
Three types of icons are used for both active jobs and jobs on hold.

Spool area
The job icons in the Spool area are described below: 

Icon: Active jobs:
(white icons and rows)

Jobs on Hold:
(yellow icons and rows)

Printer icons

PostScript, PCL, or raster 
data headed for printing 
(top) or after printing 
(bottom)

PostScript or PCL data headed for 
Print and Hold or job on Hold 
after printing (Hold)

Spool area icon: What it indicates: How long you see the job:

1

Yellow printer icon 
Yellow job row

PostScript or PCL data from a 
user on the network; no 
destination is defined

Until a destination is chosen

2

White printer icon 
White job row 

PostScript or PCL data 
headed for Print

Until the RIP is free

3

Yellow raster icon 
White job row 

PostScript or PCL data 
headed for RIP and Hold
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The Spool area is both the receiving area for jobs from users on the network (Hold 
queue) and the waiting area for jobs that will be RIPped (jobs in the Spool queue).

Hold queue jobs  When printing requires an operator (because the Print queue and 
Direct connection are disabled), the operator must assign a destination to all jobs 
received from users on the network (icon 1 in the table above). Once assigned, jobs 
(icons 2 and 3) move down the Spool queue for processing. All jobs printed to the 
Hold queue require routing by an operator.

Print queue jobs  When printing does not require an operator, network jobs sent to 
the Print queue appear in the Spool area where they are shown with a white printer 
icon (icon 2). When they reach the head of the queue, they are RIPped and printed 
without operator intervention.

Direct connection jobs  Jobs printed to the Direct connection are not displayed in the 
Command WorkStation job lists. They are displayed briefly in the status bars (where 
they cannot be selected) and are included in the Job Log.

RIP area
The job icons in the RIP area are described below: 

After a job is rasterized, it goes into the RIP area. The RIP area holds only raster data 
(i.e., jobs that have been rasterized). Jobs in the RIP area are either waiting for the 
printer to be free (Print queue jobs, icon 2 in the above table), or they are being held. 

RIP area icon: What it indicates: How long you see the job:

1

Yellow raster icon 
Yellow job row

Raster data, no destination 
defined; may have been 
printed before and held

Until it is deleted, moved to 
the Archive window, or 
stripped of its raster data and 
sent to the Spool area

2

White printer icon 
White job row 

Raster data headed for Print 
in its turn; no hold defined

Until printer is free to print 
the job
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Held jobs in the RIP area have already been rasterized (RIP and Hold) or they have 
been printed and their raster data has been routed back to the RIP area (Print and 
Hold), where they are shown in yellow rows (icon 1).

NOTE: Raster jobs in the RIP area that are waiting to print (icon 2 in the previous table) 
cannot be manipulated by job commands.

Jobs held in the RIP area remain there until the operator moves them to the Archive 
window or deletes them. Printing these jobs does not remove them from the RIP area. 
Instead, a copy of the job is created and printed.

NOTE: For all rasterized jobs, the print option settings, in addition to the current 
calibration state of the Fiery 3850C, remain with the saved raster data each time the 
job is reprinted. To print the job with new print option settings and with new 
calibration data, you must remove the raster data and reRIP the job.

Print area
The job icons in the Print area are described below:

The Print area, also referred to as the Printed queue, contains jobs that have already 
been printed. These jobs were assigned the Print destination (white printer icon in the 
Spool or RIP areas) without any Hold instructions; therefore, they all have white icons 
and rows.

Print area icon: What it indicates: How long you see the job:

1

White printer icon 
White job row 

PostScript or PCL data 
only—raster data has been 
deleted

Until the job limit is reached
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NOTE: A job row that appears in light red indicates that an error occurred while 
printing the job. To see the error, double-click anywhere in the row.

Newly printed jobs are added to the Printed queue, and are shown at the top of the list. 
Jobs are saved in the Printed queue until the job limit is reached. When the first job 
over the limit is printed, the oldest job is deleted from the disk. The value for Jobs 
Saved in Printed Queue can be changed in Fiery 3850C Setup by the administrator.

NOTE: If you reprint a job in the Printed queue, the job returns to its original position 
in the Printed queue after it is printed.

While it is printing, a job consists of PostScript or PCL and raster data. The raster data 
in RAM is not cleared until memory is needed to rasterize the next job. As long as the 
raster data is intact, the job can be reprinted from the Printed queue. Printed jobs that 
still have their raster data are represented by a white raster icon in the Printed queue 
(icon 2 in the previous table); jobs with only PostScript or PCL data remaining are 
represented by a white printer icon (icon 1). If the job was printed from a held raster 
job (in the RIP area), the raster data in the RIP area remains and can be used to reprint 
the job after the raster data has been cleared from the Printed queue.

Job commands
Job commands are used to assign a selected job to a new destination or process. These 
commands are available from the Job menu (see page 2-11). Many are also available as 
right-mouse commands (described following the list of commands below). The job 
commands available at a given time depend on the context; unavailable commands are 
dimmed. Job commands are available in the Queues and Archive windows.
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The job commands available for selected jobs in the Queues and Archive windows are 
listed in the following table. The table also describes the effect of each command on 
raster data associated with the affected job(s).

Choose this: To do this: Raster data is:

Delete Delete the job(s). Deleted

Duplicate Duplicate one or more selected PostScript or 
PCL data jobs in the Spool or Print areas. You 
can use the duplicate job(s) for different print 
options or a different destination. (The 
Duplicate command actually creates a reference 
to the original job, with the same name.)

n/a
(The Duplicate command is not available for 
raster jobs.)

Rename Rename the job (PostScript or PCL file with or 
without raster).

Unaffected, but associated with the new name

Hold Hold the job in the current place (except for a 
job in the Print area, which is moved to the 
Spool or RIP area, depending on whether it 
still has raster data associated with it).

Held in RIP area, if included with job

RIP and Hold RIP the job and hold it in the RIP area. Held in RIP area indefinitely

Print Print the job in its turn (RIP it first if it does 
not have raster data).
After printing, keep the printed job in the Print 
area until the job limit is reached.

Temporarily held in RAM after printing until 
memory is needed for another job
(If the job was printed from a held job in the RIP 
area, the raster data in the RIP area is kept 
indefinitely)

Print and Hold
(Like the user print 
option Save Fast 
Reprint)

Print the job in its turn (RIP it first if it does 
not have raster data). 
After printing, hold the PostScript or PCL data 
and the raster in the RIP area.

Held in RIP area indefinitely (saved to disk)

Process Next Give top priority to this job.
RIP (and then print) it as soon as the processor 
is free, before other waiting jobs.
Option is dimmed if there are no other waiting 
jobs.

n/a

NOTE: This command is available only for jobs 
in the Spool area that are not currently held.

Remove Raster Remove the raster data from a job that has 
raster data (indicated by a raster icon); leave the 
PostScript or PCL data unaffected.

Deleted

NOTE: If you remove raster from a job in the RIP 
area, the job is sent to the Spool area.
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Using right-mouse commands 

Use the following instructions to activate job commands with a single right-mouse 
click.

TO ROUTE JOBS WITH RIGHT-MOUSE  COMMANDS:

1. To route a single job in the job list, right-click the job.

2. Select one of the commands or destinations and release the mouse button.

The command is carried out or the job is routed to the destination you chose. 
Depending on your choice, the job line may reappear in a different part of the window 
or a different window, or the job line may be deleted.

3. To route multiple jobs at the same time, select the jobs first. 
Click the job line to select the first job. Shift-click to select adjacent jobs; 
Ctrl-click to select nonadjacent jobs.

Properties View, override print option settings, and print 
a selected job or a group of selected jobs.

Possibly deleted and regenerated, depending on 
whether you change any settings that require re-
RIPping

Thumbnail A Open the selected held raster data job in the 
Thumbnail A window where you can view a 
full-screen preview of the job, edit the job, or 
merge it with raster data from other jobs 

Changed if job is edited, unaffected if job is only 
viewed

Thumbnail B Open the selected raster data job (not 
necessarily a held job) in the Thumbnail B 
window for viewing or for merging into a job 
in the Thumbnail A window

Unchanged

Download Download files and fonts to the Fiery 3850Cr; 
see page 3-22.

n/a

Archive Archive the selected held job(s) to the Fiery 
3850C hard disk, a device on the network, or 
to the local Command WorkStation hard disk, 
and move the job icon to the Archive window; 
see page 2-27.

Archived with the job, if archiving of raster data 
is specified

Choose this: To do this: Raster data is:
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NOTE: Select jobs with the same job icon; otherwise, the destination options may not 
be the same. For example, select multiple jobs in the Spool area, and choose Print.

4. With the cursor still in one of the selected job lines, press the right mouse button.

5. Select one of the commands or destinations and release the mouse button.

The command is carried out or the jobs are routed to the destination you chose.

Archive window
If you want to store jobs before or after printing, you can archive them. The Fiery 
3850C can archive jobs internally on the Fiery 3850C hard disk. For instructions on 
how to archive jobs, see page 3-27.

NOTE: The Archive window is not available if you logged in as Guest.

PostScript, PCL, and raster data jobs can be archived, but jobs must first be held in the 
Spool or RIP areas of the Queues window before they can be archived.

When you archive a job, the job is moved, not copied, to the archive destination. The 
Archive window shows a cumulative list of all jobs that have been archived. This list is 
cleared (along with all jobs on the Fiery 3850C) by choosing Clear Server on the Fiery 
3850C Control Panel (see page 1-5) or by using the Clear command from the 
Command WorkStation (see page 2-12).
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The job icons in the Archive window are described below:

The job commands described on page 2-24 can also be used with jobs in the Archive 
window.

The icons that appear in the Archive window are always white, since they have no 
destination (as long as they are in the Archive window). 

Archive icon: What it indicates:

Printer icon

PostScript or PCL data only—raster data not present or 
deleted

Job was archived from the Spool area

Raster icon 

Raster and PostScript or PCL data

Job was archived from the RIP area

Sort order indicator

External volume



22-29 Archive window
By default, the Archive window displays all archived jobs. Until they are deleted, 
archived jobs remain in the Archive window indefinitely. You can display a subset of 
archived jobs based on various selection criteria by using the Filter command (see 
page 2-31).

For jobs archived to external devices, the Volume column shows the volume and 
pathname of the device. For jobs that were archived to the Fiery 3850C hard disk, the 
Volume column is blank. 

As with the Queues window, you can select the headings for the display and use Job 
menu or right-mouse commands; you can also sort jobs.

To: Do this:

Sort jobs in a category, such as 
by Date

Double-click the Date/Time heading. A small arrow indicates whether jobs are sorted in 
ascending or descending order. Double-click again to sort in the reverse order.

Route a job to a destination in 
the Queues window

Use job commands from the Job menu or the right-mouse command menu. For example, to 
print a job, choose Print or Print and Hold. You can also select and route multiple jobs. For 
details, see page 2-26.
The other options, RIP and Hold or Hold, send a copy of the job to the Queues window (to 
the RIP and Spool areas, respectively) without printing it; Remove Raster (which applies 
only to jobs with the raster icon) leaves only the PostScript or PCL data for the job in the 
Archive window.

View only particular jobs Choose Filter from the Window menu, and make entries in the Filter dialog box (see 
page 2-31).

Delete a job Select the job(s) and choose Delete from the Job menu or right-mouse command menu.

Display or move job ticket 
information headers in the 
Archive window

Click the right mouse button on the appropriate column head; choose Add from the 
drop-down menu to list the columns that you can add to the display. The categories are the 
same as in the Queues window (see page 2-16) but you can arrange them differently. The 
column head arrangements you set in the Archive window are independent of those you set 
in the Queues window. 

Adjust the width of a column Click the column border in the heading and drag left or right.

Export the currently displayed 
list of archived jobs to a 
tab-delimited text file

Choose Export from the Window menu. Specify a filename (the default name is archive.log) 
and a location for the file and click Save. You can then open the exported file with a 
spreadsheet, database, or word-processing application.
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Job Log window
The Job Log is a list of processed and printed jobs, the date and time they were 
processed or printed, and the characteristics of the job. It includes downloaded files 
and fonts and RIP and Hold jobs.

NOTE: The Job Log window is not available if you logged in as Guest.

At any given time, the Job Log includes only those jobs processed or printed since the 
Job Log was last cleared. The Job Log can be cleared manually by choosing “Clear Job 
Log” from the Server menu, or automatically if the administrator has enabled 
autoclearing of the Job Log in Setup. You can also clear the Job Log using the printer’s 
control panel, or the Clear command in Command WorkStation (see page 2-12). 

You can adjust the column widths in the Job Log display by clicking the column 
border in the heading and dragging left or right. For more information, see Chapter 3.

When you open the Job Log, you can choose to display all jobs in the current Job Log 
or only the jobs in a specified date range. By default, all jobs are displayed. To specify a 
date range, choose Filter from the Window menu, click Range, and enter dates in the 
From and To fields; or, click the calendar icons next to the From and To fields and 
select dates by clicking them in the calendars. Use the arrows at the upper corners of 
the calendars to display different months.

NOTE: In the Job Log window, “Start Time” reflects the time that the job began 
RIPping; “End Time” reflects the time that the job printed; and “Process Time” reflects 
the total RIP time for the job. These times do not correspond to the Date/Time values 
displayed in the Queues window.



22-31 Job Log window
Updating the Job Log display  To update the Job Log window display after specifying 
a date range (or at any other time), choose Refresh from the Window menu.

Exporting the Job Log  From the Job Log window, you can export the Job Log to a 
tab-delimited text file (the default name is job.log) by choosing Export from the 
Window menu. The exported file can be opened with a spreadsheet, database, or word 
processing application. The exported Job Log contains the jobs for the date range you 
specified.

Clearing the Job Log  The Job Log is stored on the Fiery 3850C disk. When logged in 
as Administrator, you can clear the Job Log by choosing Clear Job Log from the Server 
menu. The Job Log is cleared whenever an Administrator clears the Fiery 3850C or 
installs new software. In addition, the Job Log can be cleared automatically after every 
55 jobs.

Printing the Job Log  To print the Job Log, choose Print Pages from the File menu, 
select Job Log, click Print, and click OK. The Job Log is sent to the Print queue and 
then prints to the Fiery 3850C. You can use Job menu commands to manipulate the 
Job Log print job as you would any other job. The printed Job Log contains the jobs 
for the date range you specified. See “Using the Job Log” on page 3-27 for more 
information.

Printing and clearing the Job Log automatically  You can decide how you want to 
handle the Job Log. If you have Administrator privileges, you can choose Setup from 
the Server menu and enter your preferences in Job Log Setup. You can choose to print 
the Job Log automatically every 55 jobs, or both print and clear the Job Log 
automatically every 55 jobs. You can also choose the Job Log page size.

Filtering jobs
The Queues, Archive and Job Log windows displays a cumulative list of all jobs. If a 
large number of jobs are listed, it may be difficult to locate a particular job or a 
particular group of jobs. You can display a specified subset of jobs by filtering jobs in 
the Queues, Archive, and Job Log windows.
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To open the Filter dialog box, choose Filter from the Window menu.

In the Queues window, you can filter jobs according to any or all of the following 
criteria:

• Job title

• User name

• Date created (or a date range)

• Notes 1 or Notes 2 (Group name)

• Instructions (Group password)
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In the Archive window, you can filter jobs according to any or all of the following 
criteria:

• Job title

• User name

• Date created (or a date range)

• Notes 1 or Notes 2 (Group name)

• Instructions (Group password)

• Volume

In the Job Log window, you can filter jobs by date only.

The Filter command lets you perform a search based on any and all values you specify 
in the Filter dialog box. Enter values in all fields relevant to your filtering criteria. If 
you enter values in more than one field, only jobs that meet all the criteria are 
displayed. For example, if you enter 10 in the Job Title field and <UserName> in the 
User field, only those jobs whose titles somewhere contain “10” and whose User name 
somewhere contains “<UserName>” will be displayed.
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To filter by date, select Range in the Date created area and enter dates in the From and 
To fields; or, click the calendar icons next to the From and To fields and select dates by 
clicking on them in the calendar that appears. Click the arrows at the upper corners of 
the calendar to display different months.
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Creating Filter templates

If you often filter jobs according to specific criteria, you can create a filter template. In 
this way, you can filter jobs easily in one step and avoid the need to enter specific 
information each time you want to filter jobs.

TO CREATE A FILTER TEMPLATE:

1. Open the Filter dialog box by choosing Filter from the Window menu.

2. Enter specific job filter criteria in the appropriate fields.

3. Click Save As.

4. Enter a name for the new template and click OK.

The new template is saved in the Templates pop-up menu in the Filter dialog box.

To view jobs in the Queues, Archive, and Job Log windows according to a filter 
template, open the Filter dialog box, choose the template by name from the Templates 
pop-up menu, and click OK.
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To delete an existing template, open the Filter dialog box, choose the template by name 
from the Templates pop-up menu, and click Delete. Click OK to confirm that you 
want to delete the template.

Job properties
When logged in as Operator or Administrator at the Command WorkStation, you can 
use the Properties command to check and override the print option settings 
(properties) of all jobs. 

You can use this command to do the following:

• Override a setting based on printed output or other print device conditions

• Change settings for a duplicate of the original job

• Print a single copy of a job before printing the number of copies required by the user

Viewing and editing job properties
The Properties command lets you view, edit the print option settings of, and print 
multiple jobs simultaneously. You can use this feature to compare the properties of 
several jobs and thereby group together jobs with similar settings.
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To view the properties of one or more jobs, select the job(s) and choose Properties from 
the Job menu or the right-mouse menu.

For information on using the Properties dialog box to change job settings, see 
“Viewing and overriding print settings” on page 3-20.

NOTE: Some print options that are available in the printer driver are not displayed in 
the Properties dialog box. For information on specific print options and settings, and 
where they can be set, see Appendix A of the Printing Guide.
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Thumbnails and full-screen previews (Job Merge and 
Edit)
The Command WorkStation includes a powerful Job Merge and Edit tool that allows 
you to preview and edit raster data. (For information on how to identify a raster data 
job, see page 2-21.) Job Merge and Edit consists of two thumbnail windows and 
several page-manipulation commands (listed in the Page menu).

The Job Merge and Edit tool can be used in the following ways:

• In the Thumbnail A window, you can see thumbnails of the currently RIPping job, 
as it is processed, or of any raster data job (see “Previewing print jobs” on page 3-12).

• From the Thumbnail A and Thumbnail B windows you can open a full-screen 
preview of a raster file (see “Full-screen previews” on page 2-40).

• Using the Thumbnail A and Thumbnail B windows together, you can merge raster 
data from more than one file, even if the files were printed from different 
applications on different computer platforms (see the next section and “Merging 
raster files with Job Merge and Edit” on page 3-14). 

Job Merge and Edit’s merge features eliminate the limitations of particular software 
applications. You can merge raster pages of documents of different types, even different 
computer operating systems. You can merge color pages from graphics programs with 
text pages from a word processor. An outline of Job Merge and Edit’s features follows; 
for more information and applications, see “Merging raster files with Job Merge and 
Edit” on page 3-14. 

Editing and merging files with Job Merge and Edit
When you select a raster data job and choose the Thumbnail A or Thumbnail B 
command (from the Job menu or from the right-mouse commands), the 
corresponding Thumbnail slider opens automatically, displaying thumbnails of the file. 
To close the Thumbnail slider, click anywhere in the tab along the right edge of the 
Thumbnail window. When the Thumbnail window is open, the arrows in the tab 
point to the right, indicating that clicking the tab retracts the slider.

With the Thumbnail A window you can see thumbnail views of any raster data job—
that is, any file that is currently RIPping, or any file that has been RIPped and held to 
disk. You can also use the Thumbnail A window to edit a raster file—you can change 
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the sequence of pages, delete pages, duplicate pages, and copy pages from other raster 
files into the Thumbnail A window. You can save the edited raster file as a new 
printable document.

The Thumbnail B window can also display thumbnails of a raster job, and the 
document displayed in Thumbnail B can be used as a source for editing the document 
shown in Thumbnail A.

NOTE: Be careful not to delete all pages of a job in Thumbnail A without first saving a 
copy of the job.

You can merge documents by dragging (copying) one or more entire pages from 
Thumbnail B to Thumbnail A. This creates a new document in the Thumbnail A 
window. If you select one or more pages in the Thumbnail A window, the commands 
in the Page menu give you additional editing possibilities. (Most of the Page menu 
commands are also made available by right-clicking pages in Thumbnail A.) Multiple 
undos of Page menu commands are possible.

Thumbnail B (source)

Thumbnail A (target)

Click here to close the Thumbnail B window

Click here to close the Thumbnail A window

Click to expand or retract 
the Thumbnail B window

Click to expand or retract 
the Thumbnail A window
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You can merge pages from multiple documents into the Thumbnail A document by 
opening documents one after another in the Thumbnail B window. Documents in the 
Thumbnail B window are view-only, and while you can copy pages from Thumbnail B 
to Thumbnail A, you cannot edit the Thumbnail B document. A merged document 
that you create in Thumbnail A can be saved (with a different name) as a new raster 
data file. 

For more information, see “Merging raster files with Job Merge and Edit” on 
page 3-14.

Full-screen previews
In the Thumbnail A or Thumbnail B window, right-click a page and choose Preview 
from the menu that appears, left-click a page and choose Preview from the Page menu, 
or double-click a page to open a full-screen preview of that page. The full-screen 
preview is a view-only display, and it takes time to retrieve the data. Once begun, the 
process cannot be canceled. 

NOTE: If you have edited a raster job with Job Merge and Edit, you must save the 
edited file before you can view full-screen previews of all its pages.

Using the icons in the full-screen preview, you can display adjacent pages, rotate the 
page, or close the preview.

Click to view adjacent pages
Click to close the

full-screen previewClick to rotate 90, 180, or 
270 degrees

If scroll bar appears,
click on arrows, in empty

spaces, or move bar to
scroll up or down

If scroll bar appears, click on 
arrows, in empty spaces, or 
move bar to scroll left or right
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This chapter provides some general information about managing printing with the 
Fiery 3850C and the printer, and gives you some hints on using the Command 
WorkStation windows to monitor and manage print jobs. It suggests ways to guide 
users so that their jobs print correctly the first time. The chapter also follows the course 
of a print job and shows possible ways to expedite jobs and take advantage of the 
special capabilities provided by the Command WorkStation.

Communicating with users
The Command WorkStation interface facilitates communication between users and 
operators. All the same, users who originate print jobs may need to become better 
informed about the Fiery 3850C and the printer so they can choose the appropriate 
options for their jobs.

What the user needs to know
You or the network administrator should consider supplying the following information 
to your users:

• The name of the printer on the network and the names of servers sharing the printer

• User’s access status 

Do all jobs require operator intervention because they go to the Hold queue? If not, 
which connections are published—Direct connection and/or Print queue?

• How long you will hold jobs on the server before you delete them

• List of default printer settings and other settings (from the Configuration page)

• List of installed fonts

Chapter 3:
Managing 
Print Jobs
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Do the users’ applications download fonts automatically? If not, should users embed 
fonts in documents, or should they supply fonts to the administrator so he or she 
can download them? 

• Requirements for Notes fields (information which appears in the Job Log)

For example, department name, department code, phone number or extension. Is 
some information mandatory at your site?

• Resident calibration target and date of current measurements

• Custom simulations

Are they available? What type of targets do they represent? Users see these print 
options (CMYK Simulation) and should not select them if there are no custom 
targets on the server.

• IP address or DNS name of printer so users can access Fiery WebTools to determine 
whether their jobs have printed

• Installed option(s)

• Available media, alternative choices, standard tray/media configurations

• Suggestions for the Instructions field

• Information users might find in the WebLink web site

• Instructions for setting up the printer on client computers

• Sources of PostScript or PCL printer drivers, PPDs or PDDs, color reference files, 
and additional information

• Recommended PPD settings

• Conflicting settings and common PostScript or PCL errors
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Customizing the Command WorkStation window
You can customize the display of job ticket information in the Queues window by 
rearranging the column headings. You can tighten the columns, add new column 
headings, move columns, and delete column headings. 

NOTE: The Job Title and User columns are always at the left and cannot be moved or 
deleted. You can only add column headings to the right of the User column.

TO CUSTOMIZE THE QUEUES WINDOW DISPLAY:

1. Right-click the column heading.

A menu appears. The Add submenu lists the headings that are not already displayed.

2. Choose the options you want to display and the sequence in which you prefer to view 
them.

Add, delete, or move a column by holding down the right mouse button on the name 
of the appropriate column heading; release the button after choosing one of the menu 
options:

Add one of the listed columns to the display at your mouse position.

Move Left, Move Right—move the selected column left or right.

Delete the selected column.

The Job Title and User columns are required—all others are optional.
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3. Adjust the column widths. 

Adjust the width of a column by clicking the column border in the heading and 
dragging to the left or right. You can change the column widths at any time.

If you display the Instructions column, which shows information typed into the 
Instructions field by the user, you can reduce the width of the column so you can just 
see whether or not there are instructions in it. 

4. With a narrow Instructions column, if you want to read detailed instructions, double-
click the job and choose Notes from the Job Properties window. 

This also allows you to read the notes. You can edit or annotate the information in the 
Instructions field if you wish. It remains with the job as long as the job is on the server. 
The operator cannot edit the Notes fields.

Setting Command WorkStation Preferences
Choose Preferences from the File menu to access the Preferences dialog box.
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Menu: Choose this: To do this:

Preferences\
General

Enable Animation Turn on or off animation of the status bars

Enable Popup Help Turn on or off short captions that appear when you 
pause the mouse over window elements; the 
captions identify the main parts of the Command 
WorkStation window

Units Specify the type of unit (Points, Inches, or 
Millimeters) to use in the display for custom page 
sizes

Temporary path Specify a location for temporary files created by the 
Command WorkStation application

Preferences\
Filter

Helper Application Specify the path to a helper application from which 
to view data in the active window; this application 
opens automatically when “View in Helper App” is 
chosen from the Window menu

Template path Specify the path to where Filter template files are 
saved; for more information on Filter templates, see 
page 2-35

Preferences\
Imposition

This menu is not 
supported

n/a
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Printing Fiery 3850C information pages
Using the Print Pages command, you can print system pages stored on the Fiery 
3850C.

TO PRINT SERVER INFORMATION PAGES:

1. Choose Print Pages from the File menu.

2. In the Select Printer area, specify where you want to print the pages.

Server—The pages you specify are printed to the Fiery 3850C.

Local Printer—The pages you specify are printed to any selected printer installed on 
your Windows computer.
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3. If you specify Server, select from the following pages:

PS Test Page/PCL Test Page—A Test Page enables you to confirm that the Fiery 3850C 
is properly connected to the copier, and provides color and grayscale samples to 
troubleshoot problems with the copier or the Fiery 3850C. The following settings are 
among those listed on the Test Page: Server Name, Printer Model, color settings, 
calibration information, date and time the Test Page was printed.

Configuration—Prints the Configuration page, which gives the current server and 
device configuration. This page lists general information about the hardware and 
software configuration of the Fiery 3850C, the current settings for all Setup options, 
information about the current calibration, and the Ethernet address of the Fiery 
3850C. 

Job Log—Prints a log of the last 55 jobs processed or printed. For information on the 
fields in the Job Log and on printing it in other forms, see “Using the Job Log” on 
page 3-27.

PS Font List/PCL Font List—Prints a list of all fonts currently resident on the Fiery 
3850C hard disk.

If you specify Local Printer, select from the following pages:

Configuration—Prints the Configuration page, which gives the current server and 
device configuration. This page lists general information about the hardware and 
software configuration of the Fiery 3850C, the current settings for all Setup options, 
information about the current calibration, and IP address of the Fiery 3850C. 

Archive Log—Prints a log of all archived jobs.

Queues—Prints a log of all jobs in the Queues window. 

NOTE: The number of jobs listed under the Print area of the Queues log is specified in 
Server Setup. For more information see the Configuration Guide.
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4. Click Print.

5. If you selected Server in step 2, specify the number of copies to print and click OK.

The page(s) are printed to the Fiery 3850C.

If you selected Local Printer in step 2, choose the desired printer in the Print dialog 
box, specify the number of copies to print, and click OK.

The page is printed to the printer you specified.

NOTE: Server information pages printed with the Print Pages command appear 
in the Fiery 3850C Job Log with a User Name of “Operator” even if you logged in as 
Administrator.

Workflow scenarios
The workflow at your site will depend on the number and complexity of jobs and the 
amount of responsibility given to the operator. This section suggests some ways you 
might interact with a job.

Scenario 1 At this site, the Print queue is enabled, and anyone using the Command 
WorkStation can view the progress of jobs. You watch the job progress from the top to 
the bottom of the Queues window.

Send a job to the controller, the green light on the operation panel flashes, the network 
icon blinks; on the Command WorkStation the Spool status bar is animated and the 
job title appears. As soon as spooling has finished, the Spool status bar is cleared and 
the RIP status bar animates. Almost immediately thereafter, the RIP status bar is 
cleared and the Print status bar animates. The printed job is listed below the Print 
status bar and the job pages emerge from the printer.
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Scenario 2 At this site, all jobs come to the Hold queue and therefore require 
operator intervention to proceed.

Again, the green light on the printer flashes, the Spool status bar is animated, and now 
in the Spool area (below the status bar) the job title comes into view. In a few moments 
the job is on the list, and you have time to scan the headings for the job ticket 
information—media type, special instructions, copies, and pages.

Are you ready for this job to print? Do other jobs have priority? What is the job for—
is it final output or a test print? The first choice is whether to put the job in the print 
queue or hold it before processing it further. If you do nothing, the job remains in the 
Spool area, and the file remains on the server disk.

Perhaps this is a routine job and does not call for special handling. You right-click the 
job and choose Print. You notice the RIP status bar animate, and almost immediately, 
the Print status bar animates. The printed job is listed below the Print status bar and 
the job pages emerge from the printer.

The next job is a large job that you have not seen before. The Instructions field 
indicates that the originator of the job wants to check one printout of the job before 
you print another 50 copies. You make sure the Copies field is set to 1, right-click the 
job, and choose Print and Hold.

The RIP status bar animates and displays the job title, and then the Print status bar 
and copy 1 of the job emerges from the printer. You call the sender of the job for 
approval. When the job is approved, you set the number of copies to 50, right-click the 
job now being held in the RIP area and choose Print.
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Scenario 3 Everyone has discovered the printer on the network and jobs are coming 
in rapidly. You right-click several routine jobs in the Spool area and choose Print to let 
the server print them one after the other. You choose Print and Hold if you know you 
will be reprinting the job soon. You move jobs that have more detailed instructions (or 
need to be printed with similar jobs) to the Archive window (right-click Archive). You 
remove printed jobs from the output trays and replenish media. 

While some jobs are flowing through the queues and printing, you are preparing for 
jobs that require more attention, such as obtaining special paper, or notifying the 
originator of a job that an error occurred.

Before you load special paper, you make sure all pending jobs are in holding areas. 
When an especially important job is spooled for RIPping, you right-click Process Next. 

You flip back and forth between the Archive and Queues window. You use the Archive 
window to sort jobs into groups with similar requirements, such as media type, user 
name, or another setting, and print all the jobs of the same type in sequence.

Using the printer
If you have a printer job that has priority over the spooled incoming print jobs you can 
temporarily close the Fiery 3850C connection to the printer and then reopen it when 
you have finished copying.

When there are no active printing jobs competing for the printer engine (no white job 
lines in the Spool or RIP area), you do not need to suspend printing to make copies.
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TO GIVE THE PRINTER TOP PRIORITY AND LATER RESTORE FIERY 3850C PRIORITY:

1. From the Server menu, choose Suspend Printing, press the F5 key, or right-click the 
Print status bar and choose Suspend Printing. 

This suspends printing temporarily. Jobs continue to spool and RIP on the server as 
long as disk space and RAM are available. 

2. When you have finished with the printer job, choose Resume Printing from the Server 
menu, press the F6 key, or right-click the Print status bar and choose Resume Printing.

The printing connection between the Fiery 3850C and the printer is reopened and 
printing resumes.

Canceling jobs
You may need to cancel a job after it has been routed for processing or printing. You 
can cancel a job only while it is being RIPped or while it is being printed. You cannot 
cancel a waiting job (white job row) that is routed for RIPping or printing. 

• Canceling jobs during processing—While a job is being RIPped, and its name 
appears in the RIP status bar, choose the Cancel RIPping command from the Server 
menu, press the F7 key, or right-click on the RIP status bar and choose Cancel 
RIPping. 

When the RIP job is canceled, the Canceling message appears in the RIP status bar 
and on the Fiery 3850C Control Panel. The name of the canceled job appears in the 
Job Log.

• Canceling jobs during printing—While a job is printing, and its name appears in 
the Print status bar, choose the Cancel Printing command from the Server menu, 
press the F8 key, or right-click on the Print status bar and choose Cancel Printing. 

When the print job is canceled, Canceling appears on the Fiery 3850C Control 
Panel.The name of the canceled job appears in the Job Log. 

NOTE: Canceled jobs may be partially printed, and may include pages with one or more 
missing color planes, or pages that are completely blank.

• Canceling at the Control Panel—If you are at the Fiery 3850C, the most direct way 
to cancel a job is to press the Cancel button on the server Control Panel while you 
can read the name of the job that is processing or printing. For more information on 
the Control Panel, see Chapter 1.
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Previewing print jobs
You can use the Thumbnail A window to preview pages of the currently RIPping job. 
You can also use Thumbnail A, as well as Thumbnail B, to preview any raster data job 
in the RIP or Print areas.

The thumbnail windows also allow you to open an thumbnail view of a held raster job 
in the RIP area and perform electronic collation or document merging. This feature, 
called Job Merge and Edit, is described on page 3-14.

Previewing the currently rasterizing job
To see the progress of jobs as they are RIPped, you can leave the Thumbnail A window 
open in RIP preview mode.

TO VIEW THUMBNAILS OF THE CURRENTLY RIPPING FILE:

1. Click the Thumbnail A tab at the right of the Queues window to open the slider.

2. Click the RIP preview icon at the left side of the window.

In this mode, Thumbnail A displays each page of the currently processing job after it 
has been RIPped.

3. Choose a PS file in the Spool or Print area and select RIP and Hold, Print, or 
Print and Hold.

Click to display the currently 
rasterizing job Click to close the

thumbnail window
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As pages are RIPped, they are displayed in the Thumbnail A window. Each page is 
displayed for only a moment before the Thumbnail A window is cleared. Only one 
page is displayed at a time.

4. When you have finished viewing, click the Thumbnail A tab to close the thumbnail 
window.

TO VIEW THUMBNAILS OF ANY RASTER DATA FILE:

1. Select any raster data job in the RIP area.

2. Choose Thumbnail A or Thumbnail B from the Job menu.

If you choose Thumbnail A, make sure the raster data preview icon (at the left side of 
the window) is selected.

NOTE: Wait until all pages have been displayed before opening another raster file with 
Thumbnail A. If the job contains many pages, it may take some time for the entire job 
to be displayed.

3. When you have finished viewing, click the Thumbnail A or Thumbnail B tab to close 
the thumbnail window.

Raster data preview icon

Click to close the
thumbnail window
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Merging raster files with Job Merge and Edit
The ability to work with raster files gives you new opportunities to combine 
documents from different sources into a single raster file. For example, you can 
combine full color covers and chapter head pages created in a page layout application 
with two-color text pages created in a document processing application. Or, you can 
customize a slide presentation by inserting slides from a different presentation. 

You can display two raster files at once: a source file and a target file. The target file is 
displayed in the Thumbnail A window, the source in Thumbnail B. Both files must be 
held raster jobs in the RIP area.

NOTE: You cannot create a new PostScript or PCL file in this process; you must print 
the merged raster file, which has references to the original PostScript files. Before 
editing or merging files with Job Merge and Edit, make sure the source files were 
RIPped using the print option settings and the resident calibration you want for the 
final output. Raster files edited with Job Merge and Edit cannot be reRIPped.

TO VIEW AND EDIT RASTER DATA JOBS:

1. Select a raster data job and choose Thumbnail A from the Job menu.

The file must be a held raster job in the RIP area.

2. In the Thumbnail A window, right-click a thumbnail image to see the commands 
available for pages in Thumbnail A. 

These commands can also be accessed from the Page menu (see page 2-12) as well as 
from buttons along the left side of the Thumbnail A window (see illustration on 
page 3-15).
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To scroll through the pages in Thumbnail A, you can drag the slider bar at the bottom 
of the screen, click in the empty area to the left or right of the slider bar, or click on the 
arrows.

Delete deletes the currently selected page.

Duplicate duplicates the currently selected page.

Open Preview opens a full-screen preview of the currently selected page (see 
“Full-screen previews” on page 2-40).

Undo undoes the previous Job Merge and Edit command.

3. To move pages within Thumbnail A, left-click to select the page(s) and hold down the 
mouse button as you drag the selected page(s) to the new location.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, 
non-sequential pages. Make sure to release the Shift or Ctrl key before moving the 
pages.

If you move the page(s) on top of existing page(s), the page(s) will be overwritten.

Click to open a full-screen 
preview of the page

Click to duplicate a page

Click to delete a page
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If the icon does not have an arrow, the page(s) will be replaced; if the icon has an arrow, 
the page(s) will be inserted.

4. When you are finished editing, click the Thumbnail A tab. 

If you have edited the job, you are prompted to save the job (click Yes) and enter a new 
name.

5. Enter a new name and click OK.

The new raster file is now in the RIP area, ready to print. If you saved the edited file 
with a new name, the original source file remains held in the RIP area.

…

…

Replace single page Replace multiple pages

Move single page Move multiple pages
between two pages between two pages

…

Move single page Move multiple pages
before first page before first page

…

Move single page Move multiple pages
after last page after last page
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TO MERGE TWO RASTER DATA JOBS:

1. In the Thumbnail A window, display the document you wish to edit.

The file must be a held raster job in the RIP area.

2. Right-click another source document file (a held job with a raster icon) and select 
Thumbnail B.

The Thumbnail B tab opens a second thumbnail view which cannot be edited but can 
be a source for pages added to the document in Thumbnail A.

NOTE: To merge documents, the page sizes of the source document and the target 
document must be the same. Before editing or merging raster files with Job Merge and 
Edit, make sure the source files were RIPped using the print option settings and the 
resident calibration you want for the final output.

3. In the Thumbnail B window, left-click to select the page(s) and hold down the mouse 
button as you drag the selected page(s) to the new location in Thumbnail A.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, 
non-sequential pages. Make sure to release the Shift or Ctrl key before moving the 
pages.

To scroll through the pages in Thumbnail A and Thumbnail B, you can drag the slider 
bar at the bottom of the screen, click in the empty area to the left or right of the slider 
bar, or click on the arrows.
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To replace page(s), drag Thumbnail B page(s) on top of page(s) in Thumbnail A; to 
add page(s), drag the page(s) to a new position between pages, before the first page, or 
after the last page in Thumbnail A.

NOTE: To insert a Thumbnail B page directly after the last Thumbnail A page, drag the 
Thumbnail B page so that it is just to the right of the last Thumbnail A page and 
shows an arrow pointing to the right. If the Thumbnail B page is placed too far to the 
right of the last Thumbnail A page, the Thumbnail B page will replace the last 
Thumbnail A page.

…

…

Replace single page Replace multiple pages

Move single page Move multiple pages
between two pages between two pages

…

Move single page Move multiple pages
before first page before first page

…

Move single page Move multiple pages
after last page after last page

+

+

+

+ + +

+ +

+ +

+ +
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Multiple undos are available; use Ctrl-Z or the Undo command (from the Page menu) 
to undo all the way back to your first edit. There is no Redo function.

NOTE: Make sure to save the merged job before deleting any of the jobs you used to 
create the merged job.

Thumbnail B pages moved into Thumbnail A adopt some specific attributes of the 
Thumbnail A job, such as the document and user name. However, many color-related 
print options that are set in the Thumbnail B page, such as CMYK Simulation and 
Rendering Style, remain with the specific page. This could result in a merged job being 
made up of pages with different attributes.

4. To close the Thumbnail view, click once on the same tab you used to open it 
(Thumbnail A or Thumbnail B tab).

5. If you have edited Thumbnail A, you are prompted to save the job (click Yes) and 
enter a new name. Enter a new name and click OK.

The new raster file is now in the RIP area, ready to print, together with the original 
source and target files.

Thumbnail B

Page 4 copied from the 
document in Thumbnail B
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NOTE: If you print the edited raster file, it appears in the Job Log with the name of the 
original job, not the new name you specified for the edited job.

NOTE: In cases where multiple users are connected to the Fiery 3850C via the 
Command WorkStation, Fiery WebSpooler, and/or Fiery Spooler, and one user makes 
changes to a Thumbnail A job, not all users may see the results of those changes. If you 
are unable to view changes in a job, or if selecting a Thumbnail window results in a 
message indicating zero pages, then close and relaunch the Command WorkStation, 
Fiery WebSpooler, or Fiery Spooler.

Viewing and overriding print settings
When logged in as Operator or Administrator at the Command WorkStation, you can 
view override user job settings for, and print any job in the Queues window. Using the 
Properties dialog box, you can view and override job settings for a single job or for 
multiple jobs at once. When viewing multiple jobs, you can override settings for each 
job independently or override a setting for all the jobs at once.

NOTE: For PCL files, you are only able to override the number of copies from the 
Properties dialog box.

• To view the properties for a single job, double-click the job line or select the job and 
choose Properties from the Job menu or right mouse menu.

• To view the properties for multiple jobs at once, shift-click to select contiguous jobs, 
or Ctrl-click to select non-contiguous jobs, and choose Properties from the Job 
menu or right mouse menu.

NOTE: If you want to retain a copy of the job with its original settings, duplicate the job 
and rename the duplicate before you change any settings (see “Job commands” on 
page 2-24). 

To override a setting for a single job, right-click on the current setting and choose the 
override setting from the pop-up list.



33-21 Viewing and overriding print settings
NOTE: For some options, changing the setting requires that the job be reRIPped; these 
options show an icon to the left of the option name.

To override settings for all jobs listed in the Properties dialog box, right-click on the 
name of the print option (the row header) at the left of the dialog box and choose the 
override setting from the pop-up list.

Indicates reRIPping is required
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The Properties dialog box displays all the job settings encoded by the PostScript or 
PCL printer driver that can be decoded by the Fiery 3850C. If you (as operator) have 
not changed anything, these are the settings a user entered before sending the job. 
There is an exception to this: Scale.

NOTE: Some print options that are available in the printer driver are not displayed in 
the Properties dialog box. For information on specific print options and settings, and 
where they can be set, see Appendix A of the Printing Guide.

When the Properties dialog box opens, the page range is always shown as All pages and 
the scale is always shown as 100%. All pages denotes all the pages specified by the user 
in printing the job; it may not include all the pages in the original document on the 
user’s disk. Similarly, 100% scale indicates 100% of the magnification specified by the 
user.

The Properties dialog box does display all the remaining user settings, including user 
Instructions and Notes fields. 

• Instructions fields are intended to be viewed and annotated by the operator, but 
their contents are associated with the job and are deleted when the job is deleted 
after printing. 

• Notes fields can be viewed but cannot be changed by the operator; their contents are 
transcribed to the Job Log just as the user sent them.

Downloading files and fonts
From the Command WorkStation you can download a variety of file types, as well as 
fonts, to the Fiery 3850C. These files and fonts can be located anywhere on the 
network or on an external device connected to the Command WorkStation computer. 
You browse to locate the files and fonts, select them, and add them to a list of items to 
be downloaded. You can specify a limited number of print option settings for files that 
you download (see page 3-24).

To download fonts, the Direct connection must be used. If the Direct connection is 
not currently published in Setup, see the Configuration Guide for instructions on how 
to publish it. 
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NOTE: You cannot download TrueType fonts. If you use TrueType fonts in Windows, 
you can print them by converting them to Adobe Type 1 fonts. To do this with the 
Adobe PS printer driver, click the Fonts tab and set up the Font Substitution Table as 
necessary.

The Manage Fonts command (in the Server menu) provides another way to download 
fonts to the Fiery 3850C (see page 3-25).

TO DOWNLOAD FILES OR FONTS:

1. Choose Download from the Job menu, right-click the Spool status bar and select 
Download, or open the utilities slider and click the Downloader icon. 

The main Fiery Downloader window appears.

2. In the Files of type pop-up menu, choose the file types to display.

You can leave this at the default All Known Formats or choose All Files. All Known 
Formats lists all files in supported formats; All Files lists all files.

3. In the Connection Type pop-up menu, choose the queue to which you will download 
the files.

The options available in this menu depend on the print connections currently enabled 
in Setup. The potential choices are Print Queue, Hold Queue, or Direct Connection. 
If your administrator has not enabled one or more of these connections, you cannot 
choose it.

To download fonts, you must choose Direct Connection.

PDF files are always spooled to the Fiery 3850C hard disk before being printed. PDF 
files must be sent to the Print queue (or to the Hold queue if the Print queue is not 
enabled). Do not choose Direct Connection to download PDF files.

4. In the Look in pop-up menu, browse to the file(s) you want to download.
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5. Select the filename and click Add.

The File name field displays the name of the selected file before you click Add.

You can navigate to different drives and directories to select files and fonts to 
download. 

To select multiple sequential files, select the first file and then Shift-click the last file. 
Ctrl-click to select multiple non-sequential files.

If you change your mind about a file, select the filename in the Files to be Downloaded 
list and click Remove.

6. To change the attributes of a file, select it from the “Files to be Downloaded” list and 
click Options.

The Options dialog box for PostScript and EPS files is different from that for PDF 
files, as explained below. 

7. Specify the following information in the dialog box and click OK.

The options you set apply only to the selected file. You can set different options, or 
leave the default settings, for each file.

Copies—Specify the number of copies.

Brightness (PostScript and EPS files only)—Change the Brightness setting if a file 
appears to be too dark or too light. Choose 85% for a substantially lighter image, 
115% for a substantially darker image, or one of the options in between. 

PostScript options PDF options
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NOTE: Some applications, including Adobe Photoshop, provide transfer functions that 
let you specify density settings for an image. If the file you are printing includes 
transfer functions, the Brightness option has no effect. For more information on using 
transfer functions, see the documentation for your application.

‘showpage’ (after EPS files)—In most cases, you do not need to use this option. Select 
this option only if an EPS file fails to print without it. This option adds a ‘showpage’ 
PostScript language command at the end of the print job. Some applications omit this 
necessary PostScript language command when they generate EPS files. Select this 
option when printing EPS files generated by these applications. If you select this 
option unnecessarily, extra blank pages may print.

If you experience problems downloading EPS files, you can print the file directly from 
the application in which you created it.

Page Range (PDF files only)—Specify the page range you want to print.

8. Click Download.

To cancel downloading, click Cancel or press the <Esc> key.

Managing server fonts
The Fiery 3850C includes a number of built-in printer fonts. You can download 
additional fonts to the Fiery 3850C using the Manage Fonts command (see page 3-26) 
or the Download command (see page 3-23). Downloading fonts requires that the 
Direct connection is published in Setup (see the Configuration Guide).

NOTE: The Manage Fonts command is available only if you logged in as Administrator.

Although no special privileges are necessary to download fonts, Administrator 
privileges are required to remove fonts from the server. The built-in printer fonts are 
locked and cannot be removed by anyone.

To print a list of fonts currently resident on the Fiery 3850C, use the Print Pages 
command (see page 3-6). 
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TO ADD OR DELETE FONTS:

1. Choose Manage Fonts from the Server menu.

The Server Fonts window displays Add, Delete, Update, and Print buttons.

2. To download additional fonts to the Fiery 3850C, click Add and refer to the 
instructions on page 3-22.

3. To delete a font, select it in the font list and click Delete. Shift-click or Ctrl-click to 
select multiple fonts.

NOTE: The printer fonts included with the Fiery 3850C (built-in fonts) are locked. 
These fonts appear with a lock icon next to the name and cannot be deleted.

4. To refresh the font list display, click Update.

5. To print the font list, click Print.

Click to update the font list display

Click to delete font(s)
Locked fonts Click to download additional fonts

Downloaded fonts
Click to print the font list
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Archiving jobs
PostScript or PCL and raster data jobs can be archived internally to the Fiery 3850C 
hard disk.

TO ARCHIVE A POSTSCRIPT OR RASTER JOB:

1. In the Queues window, select any held job in the Spool or RIP areas.

2. Choose Archive from the Job menu.

The job is moved to the Archive window.

3. To archive the job(s) internally to the Fiery 3850C hard disk, click OK.

The job(s) are archived internally.

Using the Job Log
Chapter 2 introduced the Job Log, which is the list of all processed and printed jobs, 
including the date and time they were printed, and all the characteristics of the job. It 
explained that the Administrator can set Job Log preferences for clearing and printing 
the Job Log automatically, and for Job Log page size (page 2-30).

If you want to view the Job Log in a specific application, you can specify one in the 
Preferences dialog box (see page 3-4), then select View in Helper App from the 
Window menu.

After displaying the Job Log you can print it (use the Print Pages dialog box or 
choose Print from the Window menu), or export it to a tab-delimited text file (choose 
Export from the Window menu). The exported Job Log file can be imported into a 
spreadsheet, database, or word processing application for job accounting purposes. If 
the Filter command is used to display only a portion of the Job Log (such as jobs for 
the current day), only that portion of the Job Log is printed or exported.

To update the Job Log, choose Refresh from the Window menu.

After printing or exporting the entire Job Log, you may want to clear it; choose Clear 
Job Log from the Server menu.



33-28 Managing Print Jobs
The Job Log window displays a list of all the jobs and the following information about 
them: status, document name, user, date, start time, end time, process time, size, 
device, page size, media, number of originals, number of color pages, number of black 
and white pages, and total number of pages. Information in the Notes 1 and Notes 2 
fields is displayed if users entered this information when they printed.

NOTE: If a raster job was saved with a new name and then printed, it appears in the Job 
Log with the name of the original job, not the new name you specified for the edited 
job.

The text in the Status column provides information about the job: 

Use the scroll bar at the bottom of the window to view all the fields in the Job Log 
window.

OK The job was printed normally.

Cancel The job was canceled before printing was completed.

Error An error occurred during processing or printing.
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Other server management commands
These additional Server menu commands are used to manage server performance, 
configuration, and status. Some of these commands are available only when logged in 
as Administrator:

• Manage Fonts—Allows you to delete fonts from, as well as add fonts to, the Fiery 
3850C (see page 3-25)

• Reboot—Causes the Fiery 3850C to be rebooted, just as if you had selected Restart 
Printer from the Control Panel (see page 1-10)

• Clear—Clears all jobs in all server queues as well as all jobs archived on the Fiery 
3850C hard disk, the index of archived jobs (in the Archive window), and the Job 
Log

• Setup—Invokes Fiery Setup; for more information, see the Configuration Guide

• Log out—Closes the connection to the Fiery 3850C, just as if you had chosen Log 
out from the log in/out slider
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This chapter introduces Fiery WebTools and provides instructions on their usage. For 
more information on certain Fiery WebTools you are referred to other chapters in this 
book and to other manuals in the documentation set.

Fiery WebTools
Fiery WebTools reside on the Fiery 3850C but can be accessed over the network from 
a variety of platforms. The Fiery 3850C has a home page that lets remote users view 
server functions and manipulate jobs. 

Fiery WebTools can be used on Mac OS and Windows client computers with certain 
Internet browsers that support the Java language. For specific information on the 
browsers supported with Fiery WebTools, see Getting Started.

Access privileges
The Fiery 3850C system allows the site administrator to choose and implement a level 
of access and control appropriate for your particular site. There is a spectrum of control 
which can be implemented; the levels of access allowed to remote users depend on 
whether the administrator has enabled use of Fiery WebTools, and whether or not a 
password is required to use the job management features of Fiery WebTools. 

If you have been given the Operator password, you can manage job flow and override 
print settings of your jobs with Fiery WebSpooler. If not, you can still track the status 
of your jobs with the Status tool, and with Fiery WebSpooler as a Guest. Check with 
your site administrator for information on your Fiery WebTools access privileges.

Chapter 4:
Overview of 
Fiery WebTools
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Using Fiery WebTools
Fiery WebTools are accessed from the Fiery 3850C home page.

WebTool: Summary: For more information:

Status Shows you the jobs currently 
processing and printing.

See the Printing Guide.

WebSpooler Allows you to view, manipulate, 
reorder, reprint, and delete jobs 
currently spooling, processing, or 
printing on the Fiery 3850C. It also 
allows you to view, print, and delete 
the Job Log.

See “Tracking and managing 
jobs with Fiery WebSpooler” 
on page 5-1.

WebLink Provides a link to another web page, 
provided you have a valid Internet 
connection. The WebLink destination 
can be changed; this function requires 
the Administrator password, if one has 
been set.

See the Printing Guide and the 
Configuration Guide.

WebSetup Allows you to modify the Command 
WorkStation configuration (Setup) 
remotely. This function requires the 
Administrator password, if one has 
been set. This utility is not available on 
Mac OS.

See the Configuration Guide.

WebDownloader Allows you to download files or fonts 
to the Fiery 3850C. 

See “Downloading files and 
fonts” on page 3-22.
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TO ACCESS FIERY WEBTOOLS:

1. Start your Internet browser application. 

2. Enter the IP address or the DNS name of the Fiery 3850C.

Check with the operator or administrator for this information.

The Fiery 3850C home page appears.

3. Click one of the buttons at the left to select one of the Fiery WebTools.

Move the cursor over the buttons to display information about the selections.





55-1 Tracking and managing jobs with Fiery WebSpooler
Fiery WebSpooler is a job management tool that duplicates many of the functions and 
features of the Command WorkStation. Fiery WebSpooler is one of the 
Fiery WebTools, and is accessed with an Internet browser and the Fiery 3850C home 
page (see Chapter 4). 

The interface of Fiery WebSpooler is so similar to that of the Command WorkStation 
that this chapter often refers you to Chapters 2 and 3 (on the Command WorkStation) 
for information about icons and commands that is common to both tools.

Tracking and managing jobs with Fiery WebSpooler
You can use Fiery WebSpooler to perform the following functions from your 
workstation:

• Override current job option settings

• Delete jobs and cancel processing

• Duplicate or rename jobs

• RIP a job and hold the raster data

• Hold jobs in the spooled area or the RIPped area

• Remove raster data from RIPped files

• Change the priority of jobs

• Display, print, or delete the Job Log 

Chapter 5:
Fiery WebSpooler 



55-2 Fiery WebSpooler
Most of these functions require the Administrator or Operator password. However, 
even without a password, you can log in to Fiery WebSpooler as Guest with view-only 
privileges.

NOTE: Most Fiery WebSpooler commands function identically to those of 
the Command WorkStation. For more information on specific commands, see 
Chapter 2 and 3.

TO ACCESS THE FIERY WEBSPOOLER WINDOW:

1. From the Fiery 3850C home page window, click WebSpooler.

For instructions on how to access the Fiery 3850C home page window, see page 4-3. 

2. To log in as Administrator, enter the Administrator password and click OK.
To log in as Operator, enter the Operator password and click OK.
To log in as Guest, click OK, without entering any password.

The Fiery WebSpooler window appears in a new browser window.
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About the Fiery WebSpooler window
Like Command WorkStation, Fiery WebSpooler is a window to view and control Fiery 
3850C functions.

The Fiery WebSpooler window is divided into three areas by Spool, RIP, and Print 
status bars. When the Fiery 3850C receives print jobs, the Fiery WebSpooler window 
becomes a dynamic display, filled with the names of jobs and their characteristics.

The Spool, RIP, and Print areas of the Fiery WebSpooler window represent the stages 
of printing a job. Jobs come in at the top level (Spool) and drop down to the Print 
level, unless they are held along the way.

The job icons displayed in the Fiery WebSpooler window are explained in “Job icons” 
on page 2-21.

NOTE: In the Fiery WebSpooler window, the background color for the yellow and white 
printer icons is the same.

Spooled jobs—Jobs listed in the area below the Spool status bar are PostScript or PCL 
files stored on the Fiery 3850C disk. These jobs were sent to either the Print queue 
(white icons) or the Hold queue (yellow icons).

RIPped jobs—Jobs listed in the area below the RIP status bar are ready to print. They 
have already been rasterized (RIPped, or processed for printing) and are waiting, in 
order, for access to the printer. Rasterized jobs can also be held; held jobs are shown 
with a yellow icon.

Printed jobs—Jobs listed in the area below the Print status bar have already been 
printed. Printed jobs can be stored on the Fiery 3850C disk. The number of jobs that 
can be stored (from 1 to 99) is defined in Setup.
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If you are logged in as Administrator or Operator, you can interact with a job wherever 
it appears in the window by selecting it and choosing a command from the Job menu, 
or by double-clicking the job and setting override options. See “Manipulating job 
options and job flow” on page 5-4 for information.

Errors—Jobs with an error are shown in red. To display the error, double-click the 
job line. 

NOTE: If your job does not appear anywhere in the Fiery WebSpooler window, it may 
have already been printed; if so, it will appear in the Job Log. To view the Job Log, 
choose Show Job Log from the Window menu. (For more information on the Job Log, 
see page 5-9.)

If the job does not appear in the Job Log, it may have been moved to the 
Archive window by the operator. The Archive window cannot be viewed with 
Fiery WebSpooler; you must contact the operator or look at the Command 
WorkStation display to check this.

Manipulating job options and job flow
Using the commands in the Job menu, you can alter the destinations, priorities and 
other characteristics of jobs that appear in the Fiery WebSpooler window.
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To understand the effect each of these commands has on a job, you need to understand 
the way the Fiery 3850C handles PostScript, PCL, and raster data, and how jobs are 
activated or held in the various stages of processing. See Chapter 2 for this background 
information before manipulating jobs with Fiery WebSpooler. Also, the commands in 
the Fiery WebSpooler Job menu have identical counterparts on the Command 
WorkStation. For background and information about these commands, see Chapters 2 
and 3.

Choose this command 
from the Job menu: To do this: Raster data is:

Delete Job(s) Delete the job(s) from the list. Deleted

Duplicate Job(s) Duplicate one or more selected PostScript or 
PCL data jobs in the Spool or Print areas 
(creates a reference to the original job, with the 
same name).

n/a
(The Duplicate command is not available for 
raster jobs.)

Rename Rename the job (PostScript or PCL file with or 
without raster).

Unaffected, but associated with the new name

NOTE: If the renamed job is printed, the Job 
Log reflects the job’s original name.

Hold Hold the job in the current place (except for a 
printed job, which is moved to the Spool or 
RIP area).

Held in RIP area indefinitely, if included with 
job

RIP and Hold RIP the job and hold it in the RIP area. Held in RIP area indefinitely

Print Print the job in its turn (RIP it first if it does 
not have raster data). Keep the printed job in 
the Print area until the job limit is reached.

Temporarily held in RAM until memory is 
needed for another job

Print and Hold
(like the PPD option 
Save Fast Reprint)

Print the job in its turn (RIP it first if it does 
not have raster data).
After printing, hold the PostScript or PCL data 
and the raster in the RIP area.

Held in the RIP area indefinitely (saved to 
disk)
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Overriding job option settings
To change the job options of a job, double-click the job line or select the job and 
choose Override Print Settings from the Job menu. If necessary, scroll down to see all 
the various job options.

Process Next Give top priority to this job.
Print the job (or RIP and print) as soon as the 
processor and copier are free, before other 
waiting jobs.

Held in RAM after printing (can be selected in 
the Print area while it remains there), or Held 
in RIP area (saved to disk) if destination was 
RIP and Hold

Remove Raster Remove the raster from a job that has raster 
data; leave the PostScript or PCL job in place.

Deleted

Override Print Settings Change the print options for the job
(see page 5-6).

Deleted and regenerated, if the newly selected 
options require reRIPping, or reprinted with 
the new settings, if none require reRIPping

Thumbnail A  Open the selected held raster data job in the 
Thumbnail A window where you can view a 
full-screen preview of the job, edit the job, or 
merge it with raster data from other jobs 

Changed if job is edited, unaffected if job is 
only viewed

Thumbnail B Open the selected raster data job (not 
necessarily a held job) in the Thumbnail B 
window for viewing or for merging into a job 
in the Thumbnail A window

Unchanged

Choose this command 
from the Job menu: To do this: Raster data is:
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For PostScript files, you cannot override the Orientation option.

For PDF files printed using Fiery Downloader, you cannot override the following print 
options:

• Orientation

• Spot Color Matching

For PCL files, you can only override the Copies option. 

The options you set here are the same ones you set from the Print dialog box when you 
print from an application. For information about setting and overriding these print 
options, see the Printing Guide.

NOTE: For some options, changing the setting requires that the job be reRIPped; these 
options show an icon to the left of the option name.

Thumbnails and full-screen previews (Job Merge and Edit)
Like the Command WorkStation, Fiery WebSpooler includes a powerful Job Merge 
and Edit tool that allows you to preview and edit raster data. Job Merge and Edit 
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consists of two thumbnail windows and several page-manipulation commands (listed 
in the Page menu). The Job Merge and Edit tool can be used in the following ways:

• In the Thumbnail A window, you can see thumbnails of the currently printing job, 
as it is processed, or of any raster data job.

• From the Thumbnail A window you can open a full-screen preview of a raster file.

• Using the Thumbnail A and Thumbnail B windows together, you can merge raster 
data from more than one file, even if the files were printed from different 
applications on different computer platforms. 

Job Merge and Edit’s merge features eliminate the limitations of particular software 
applications. You can merge raster pages of documents of different types, and even 
different computer operating systems. You can merge color pages from graphics 
programs with text pages from a word processor. 

NOTE: In cases where multiple users are connected to the Fiery 3850C via 
Fiery WebSpooler or Command WorkStation, and one user makes changes to a 
Thumbnail A job, not all users may see the results of those changes. If you are unable 
to view changes in a job, or if selecting a Thumbnail window results in a message 
indicating zero pages, then close and relaunch Fiery WebSpooler or Command 
WorkStation.

Job Merge and Edit differences in Fiery WebSpooler

The Job Merge and Edit tool in Fiery WebSpooler functions almost identically to that 
in the Command WorkStation. For detailed information on using Job Merge and Edit, 
see Chapters 2 and 3 (for instructions on editing and merging raster files, see “Merging 
raster files with Job Merge and Edit” on page 3-14). Though the interfaces are almost 
identical, there are some feature differences:

• You cannot scroll through the pages in Thumbnail A or Thumbnail B by dragging 
the slider bar at the bottom of the screen.

• Thumbnail A right-click commands are not available; instead click on a page to 
select it, and either click the appropriate button in the Thumbnail A window or 
choose the appropriate command from the Page menu.
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• Page icons and arrows do not appear when moving page(s) from Thumbnail B to 
Thumbnail A. Instead, a blue outline appears around a Thumbnail A page that is to 
be replaced; and a blue bar appears adjacent to or between Thumbnail A page(s) to 
indicate where the Thumbnail B page(s) are to be inserted.

• The full-screen preview window has a status bar (the Command WorkStation does 
not), the “X” button used to close the full-screen preview is in a different location, 
there are no page advance arrows, and there is no rotate button.

• Multiple undos are not available.

• The Ctrl-Z keyboard shortcut for the Undo command is not available. To undo one 
or more Job Merge and Edit commands, choose Undo from the Page menu.

Using the Job Log
From Fiery WebSpooler, you can view and print a log of all jobs printed by the Fiery 
3850C, including jobs downloaded with Fiery Downloader. You can also save the Job 
Log to a text file which you can then import into a spreadsheet or word processing 
application for job accounting purposes. 

NOTE: If you logged in as Administrator, you can delete the Job Log from 
Fiery WebSpooler (see page 5-10). The Job Log is not available if you logged in as 
Guest.

TO DISPLAY, UPDATE, PRINT, DELETE, AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Fiery WebSpooler Window menu.

2. Click All or specify a date range.
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3. Click OK.

The Job Log appears in a new browser window.

NOTE: The Delete button appears only if you logged in as Administrator.

The Job Log displays each job and the following information: status, document name, 
user name, date, start time, end time, process time, file size, device, paper size, media, 
number of originals, number of color pages, number of black-and-white pages, total 
number of pages, Note1, and Note2.

The Status column provides the following information about jobs:

4. To update the Job Log, click the Update button.

5. To print the Job Log, choose Print Job Log from the File menu or click the Print 
button.

The information displayed in the Job Log window prints to the current Fiery 3850C. 
When you print the Job Log, totals are printed for all appropriate columns.

6. If you logged in as Administrator, you can choose Delete Job Log from the File menu 
or click the Delete button to clear the Job Log.

The system administrator can also print and clear the Job Log from the Control Panel.

To return to the job list, choose Show Job List from the Window menu.

OK The job was printed normally.

ERROR An error occurred during processing or printing.

CANCEL The job was canceled before printing was completed.



AA-1 Troubleshooting
This section lists error messages you might see, and provides some troubleshooting 
guidelines should a problem arise with the Fiery 3850C or the Command 
WorkStation. If you are unable to resolve a problem after referring to this chapter, 
contact your authorized service/support center. 

Error messages
Error messages can result from problems with the print job, the Fiery 3850C, the 
Command WorkStation, or the printer. Some of the most common error conditions 
are listed here.

A printer error message sometimes remains displayed for a short time on the 
Command WorkStation even after you have resolved the error. However, printing will 
resume and the Command WorkStation display will be updated after a short delay.

When an error interferes with printing, you will see a message at the Command 
WorkStation. The status bar that displays the message indicates the process where the 
error occurred. Following are the messages (listed in alphabetical order), with the 
appropriate corrective action for each one. You can cancel the pending print job while 
you attend to the error condition. A few normal status messages are included in this list 
in case they cause concern.

Fiery 3850C 
message: Corrective action/additional information:

<tray> Load <media 
type> <media size>

The paper currently loaded in the specified tray does not match 
the paper required, or there is no paper currently loaded in the 
tray. Please load the specified paper in the tray.

Tray 1 empty
<media type> <media 
size>

Tray 1 has run out of the specified paper.

Tray 2 empty
<media type> <media 
size>

Tray 2 has run out of the specified paper.

Appendix A: 
Troubleshooting
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Load Paper
Tray <number>

The specified tray is empty. Please load paper in the tray.

Reset Tray <number> 
Correctly

The specified tray is open or not closed correctly. Please close the 
tray.

Replace 
Transfer Unit

Replace the Transfer Unit.

Replace Fuser Oil
Unit soon

The fuser oil unit is near the end of its life span. Please replace the 
unit.

Add
Staples

Add staples to the stapler unit, if installed.

Punch-hole Chips
are Full

The punch-hole chip waste bin is full. Please empty it.

Remove Paper
Inside Finisher

There is paper inside the finisher unit. Please remove it.

Reset Duplex
Unit Correctly

The duplex unit is not aligned correctly. Please reset it.

Toner is Almost
Empty: Yellow

The yellow toner is almost empty. Prepare to refill it.

Toner is Almost
Empty: Magenta

The magenta toner is almost empty. Prepare to refill it

Toner is Almost
Empty: Cyan

The cyan toner is almost empty. Prepare to refill it

Toner is Almost
Empty: Black

The black toner is almost empty. Prepare to refill it

Add Toner:
Black

The black toner is empty. Please refill it

Add Toner:
Cyan

The cyan toner is empty. Please refill it

Add Toner:
Magenta

The magenta toner is empty. Please refill it

Fiery 3850C 
message: Corrective action/additional information:
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Add Toner:
Yellow

The yellow toner is empty. Please refill it

Waste Toner is 
Almost Full

The waste toner receptacle is almost full. Please empty it.

Hardware Problem
Staple Unit

The stapler unit is not functioning properly. Please check it.

Hardware Problem
Tray <number>

The specified tray is not functioning properly. Please check it or 
call service.

Hardware Problem
Finisher

The finisher is not functioning properly. Please check it or call 
service.

Remove Paper
Mailbox Tray 
<number>#

The indicated mailbox tray is full. Please remove paper from it. 

Remove Paper
Finisher Tray 
<number> 

The indicated finisher tray is full. Please remove paper from it.

Remove Paper
Standard Tray

The standard tray is full. Please remove paper from it.

Remove Paper
All Output Trays

Please clear all output trays. 

Reset Toner
Black

The Fiery 3850C cannot detect the black toner unit. Please 
reinsert it and close the cover. 

Reset Toner
Cyan

The Fiery 3850C cannot detect the cyan toner unit. Please reinsert 
it and close the cover. 

Reset Toner
Magenta

The Fiery 3850C cannot detect the magenta toner unit. Please 
reinsert it and close the cover. 

Reset Toner
Yellow

The Fiery 3850C cannot detect the yellow toner unit. Please 
reinsert it and close the cover. 

Replace Fuser
Oil Unit 

Please replace the fuser oil unit.

Replace Waste
Toner

The waste toner bottle is full. Please replace it.

Fiery 3850C 
message: Corrective action/additional information:
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Reset Waste
Toner Correctly

The Fiery 3850C cannot detect the waste toner bottle. Please 
reinsert it and close the cover. 

Reset Finisher
Correctly

The Fiery 3850C cannot detect the finisher. Please reattach or reset 
it. 

Close Lower
Right Cover

The lower right cover is open. Please close it.

Close 
Mailbox Cover

The mailbox cover is open. Please close it.

Close Duplex
Unit Cover

The duplex unit cover is open. Please close it.

Close Finisher
Upper Cover

The upper cover of the finisher is open. Please close it.

Close Finisher
Front Cover

The front cover of the finisher is open. Please close it.

Close Upper
Right Cover

The upper right cover is open. Please close it.

Close 
Right Cover

The right cover is open. Please close it.

Close Upper
Left Cover

The upper left cover is open. Please close it.

Close 
Front Cover

The front cover is open. Please close it.

Reset Develop.
Unit Correctly
Black

The Fiery 3850C cannot detect the black developer unit. Please 
reinsert it and close the cover. 

Reset Develop.
Unit Correctly
Cyan

The Fiery 3850C cannot detect the cyan developer unit. Please 
reinsert it and close the cover. 

Reset Develop.
Unit Correctly
Magenta

The Fiery 3850C cannot detect the magenta developer unit. Please 
reinsert it and close the cover. 

Fiery 3850C 
message: Corrective action/additional information:
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Reset Develop.
Unit Correctly
Yellow

The Fiery 3850C cannot detect the yellow developer unit. Please 
reinsert it and close the cover. 

Reset PCU
Correctly
Black

The Fiery 3850C cannot detect the black photo conducting unit. 
Please reinsert it and close the cover. 

Reset PCU
Correctly
Cyan

The Fiery 3850C cannot detect the cyan photo conducting unit. 
Please reinsert it and close the cover. 

Reset PCU
Correctly
Magenta

The Fiery 3850C cannot detect the magenta photo conducting 
unit. Please reinsert it and close the cover. 

Reset PCU
Correctly
Yellow

The Fiery 3850C cannot detect the yellow photo conducting unit. 
Please reinsert it and close the cover. 

Reset Fuser Oil
Unit Correctly

The Fiery 3850C cannot detect the fuser oil unit. Please reinsert it 
and close the cover. 

Reset Transfer
Unit Correctly

The Fiery 3850C cannot detect the transfer unit. Please reinsert it 
and close the cover. 

Reset Fusing
Unit Correctly

The Fiery 3850C cannot detect the fusing unit. Please reinsert it 
and close the cover. 

Remove Misfeed
W: Mailbox
Open
Mailbox Cover

There is a paper misfeed in the mailbox. To remove the paper, 
open the mailbox front cover and follow the instructions inside the 
cover.

Remove Misfeed
Z1:Duplex Unit
See Instructions
in Front Cover

There is a paper misfeed in the duplex unit. To remove the paper, 
open the front cover and follow the instructions inside the cover.

Remove Misfeed
Z2:Dup.Feed Unit
See Instructions
in Front Cover

There is a paper misfeed in the duplex feed unit. To remove the 
paper, open the front cover and follow the instructions inside the 
cover.

Fiery 3850C 
message: Corrective action/additional information:
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Maintaining optimal system performance
The Fiery 3850C does not require maintenance. Beyond the routine requirements of 
servicing and maintaining the print engine and replenishing consumables there are a 
few things you can do to improve the overall performance of your system:

• Schedule the printing workload by checking job ticket information before printing. 
Print jobs with the same output and paper specifications together to minimize paper 
changes. Also, print routine jobs while you prepare to print jobs with special 
instructions or special media.

• Reduce unnecessary Fiery 3850C connections at the Command WorkStation. If you 
use a second or third Fiery 3850C on an occasional basis, performance will be 
improved if you log off when you are not using it.

• Avoid printing when the Fiery 3850C displays the Disk full warning. 

If you see this warning, delete jobs from the Queues window that have been held for 
a long time and are not likely to be needed. Avoid this condition by deleting old jobs 
on a regular basis. The date associated with a job is the original date it was sent.

As a last resort, you can use the Clear Server or the Clear command.

Remove Misfeed
R: Finisher
Open
Finisher Cover

There is a paper misfeed in the finisher unit. To remove the paper, 
open the finisher cover and follow the instructions inside the cover.

Remove Misfeed
A: Internal Path
See Instructions
in Front Cover

There is a paper misfeed inside the Fiery 3850C. To remove the 
paper, open the front cover and follow the instructions inside the 
cover.

Remove Misfeed
Y: Paper Tray
See Instructions
in Front Cover

There is a paper misfeed in a paper tray. To remove the paper, open 
the front cover and follow the instructions inside the cover.

Remove Misfeed
B: Fusing Unit
See Instructions
in Front Cover

There is a paper misfeed in the fusing unit. To remove the paper, 
open the front cover and follow the instructions inside the cover.

Fiery 3850C 
message: Corrective action/additional information:
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Troubleshooting
In case of problems, and before you call for service, check the guidelines in this section. 
If you are unable to resolve the problem, make a note of the error condition and 
contact your authorized service/support center.

Command WorkStation hangs
If the Command WorkStation windows do not update, try clicking the Log in/out 
slider and logging out, and then exiting the Command WorkStation. Restart the 
Command WorkStation application or restart the computer.

If the Command WorkStation windows do not update, or no jobs are displayed, and 
the mouse has no effect (you cannot select a job or a window, use a right mouse 
command, or select a menu item) the Fiery 3850C is down or communication over the 
network has failed.

To force an exit from the Command WorkStation application, press Ctrl-Alt-Delete, 
and with the Command WorkStation selected, click End Task. At the Fiery 3850C, 
disconnect and reconnect the network cable, and try printing a Test Page or 
Configuration page. If that fails, reboot the Fiery 3850C.

Command WorkStation fails to connect to the Fiery 3850C
If a remote Command WorkStation cannot connect to a Fiery 3850C that was 
connected previously, you may need to reconfigure the connection.

1. If you can, choose Exit from the Command WorkStation File menu.

2. In the C:\Windows folder, find the Efinl.ini file and move it out of the C:\Windows 
folder to another folder. 

If the Efinl.ini file contains a limited amount of configuration information that is easily 
recreated (i.e., information for only one or two servers), you can delete the file 
altogether. A new Efinl.ini file will be created in the C:\Windows folder when you 
reconfigure the connection.

If the Efinl.ini file contains configuration information for several servers, or 
information that is not readily recreated, keep the Efinl.ini file as a backup.
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3. Print a Configuration page.

You will use the information on this page to configure the connection to the Fiery 
3850C.

Make sure that the printer is online. CWS cannot connect to the printer if it is not 
online.

4. Launch the Command WorkStation application.

5. When you are prompted to configure a server connection, click OK. 

Use the instructions in Getting Started to configure the connection.

6. If you still cannot connect to the Fiery 3850C, the administrator should reinstall 
Command WorkStation software. 

See Getting Started for details.
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Unexpected printing results

If this happens: This is the problem:

A cover page is not printed 
when you reprint a saved 
raster job.

The cover page identifies the originator of the job and the 
time the job was sent. Time stamp and user information on 
the cover page of a reprinted job are not meaningful.

The job settings are not 
carried out as you expected.

If the user printed from Mac OS, there may be two 
conflicting print settings. You can check the job properties by 
double-clicking the job. See the Printing Guide for a table of 
job properties and conflicting properties. Notify the users of 
these conflicts so they can avoid them in the future.

The job does not print. Some printing errors may be displayed in the Print status bar. 
When the job is in the Printed queue, jobs that had an error 
are displayed in a light red job row. Double-click anywhere in 
the row to see the error message.

There are font errors. If user-specified fonts that are not resident on the Fiery 
3850C are not printing correctly in PostScript or PCL files 
that are downloaded by users, request that they embed the 
fonts in the PostScript file or print directly from their 
application. When users print from their applications, if 
special fonts are not downloaded automatically, they should 
be downloaded directly to the Fiery 3850C with Command 
WorkStation. This can be done by the user or by the operator, 
provided the Direct connection is enabled. For information 
about downloading fonts, see the “Downloading files and 
fonts” on page 3-22.
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Clearing the server
Clearing the server is an Administrator option that can be used as a last resort if a job 
persists in the system and prevents printing despite attempts to cancel or delete it. 
Clearing the server deletes all jobs currently saved on the server in any queue. It also 
clears the Job Log.

Before clearing the server, export the Job Log if you have not recorded the information 
in it. If you can, notify users that you will clear their jobs from the server so they can 
back them up and resend them when the server is back in operation.

You can clear the server from the Control Panel (see page 1-5) or by using the Clear 
command from the Command WorkStation).

Users are unable to connect to the Fiery 3850C
If users are unable to connect to the Fiery 3850C, or are unable to find the Fiery 
3850C from their workstations, the network administrator may need to troubleshoot 
their network connections, and check settings on the servers they use for printing. If 
settings have changed, it may be necessary to reconfigure the Fiery 3850C.

For example, if print servers or print queues on a Novell server are renamed or deleted, 
or if accounts or permissions are changed, the Fiery 3850C administrator may have to 
edit settings or enter new settings in IPX (Novell) Setup to reflect the new 
configuration.

If users cannot connect to the Fiery 3850C from a Windows computer, you may need 
to reconfigure the utility’s connection to the server. See Getting Started for details.



AA-11 Troubleshooting
Mac OS users may fail to see the Fiery 3850C if a network administrator has assigned 
it to a different zone, or has added zones where previously there were none.

If you have configured the Fiery 3850C and set up client computers and network 
servers according to guidelines in the Configuration Guide and Getting Started, try 
printing a Test Page (at the Command WorkStation, choose Print Pages from the File 
menu).

If you are able to print the test page but still cannot print a file from a remote 
computer, contact the system administrator to troubleshoot the network connection.

If you are unable to connect, and you cannot print the Test Page, check the printer’s 
touch panel display.

Setup error messages
For information on Setup error messages, see the Configuration Guide.

If this happens: Try this:

It displays a diagnostic or 
error message

Take the appropriate corrective action, as described in the 
printer manual or in the section “Error messages” on 
page A-1.

The printer is not in 
Standby mode

The printer’s Automatic Power-Off function may have shut 
down the printer. 
Turn the printer on, and then try printing a Test Page again 
when the printer has warmed up.

You still cannot print a 
Test Page

Make a copy. If you can make a copy, restart the Fiery 3850C, 
and when you see Idle on the status line of the Fiery 3850C 
display, try printing a Test Page again. If the Test Page still 
fails to print, contact your authorized service/support center.
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A
About command 2-13
access

levels xv, 2-6
restricting xiv

active jobs 2-19
activity lights, on Control Panel 1-2
adjusting columns (Queues window) 2-16
Administrator password xv, 2-1, 2-6
Adobe Photoshop,  see Photoshop
animation, see status bars
Archive command 2-11, 2-26, 3-27
archived jobs, filtering 2-29
Archive window 2-28, 5-4

adjusting column width 2-29
changing displayed headers 2-29
exporting job list 2-29
features 2-29
job icons 2-28
routing jobs 2-29
sorting jobs 2-29

archiving a job 2-19, 2-26

C
Cancel Printing command 2-12, 3-11
Cancel RIPping command 2-12, 3-11
Clear command 2-12, 3-29

clears archived jobs 2-27, 2-30, A-10
Clear Job Log command 2-12
Clear Server command

clears archived jobs 2-27
Command WorkStation 5-4

Archive window 2-28
display, described 2-7
introduction to 2-1
Job Log window 2-31
logging in to server 2-5
main window, parts of 2-7

menus 2-10
Queues window 2-7
starting 2-4
troubleshooting A-7, A-8

Configuration page A-8
printing from the Command 

WorkStation 3-7
Configuration page, printing 1-5
connection to server, configuring 2-4
Control Panel 1-1 to 1-3

Cancel button 1-3
Enter button 1-3
Menu button 1-2
Navigation buttons 1-2

D
Delete (job) command 2-11
Delete (page) command 2-12
Delete command 2-25, 3-15
Delete Job command (Fiery 

WebSpooler) 5-5
differences

between DocBuilder for Fiery 
WebSpooler and for the 
CommandWorkStation 5-8

Direct connection 2-22, 3-25, A-9
DocBuilder 3-14 to 3-20

Delete command 3-15
Duplicate command 3-15
editing options 3-15
merging two files 3-18
Open Preview command 3-15
Undo command 3-15

DocBuilder differences 5-8
Download command 2-11, 2-26, 3-23 to 

3-25
downloading files and fonts 3-22
Duplicate (job) command 2-11



I-2 Index
Duplicate (page) command 2-12, 3-15
Duplicate Job command (Fiery 

WebSpooler) 5-5

E
Efinl.ini file A-7
Enable Animation 3-5
Enable Popup Help 3-5
error display 2-18
error messages A-1 to A-6

during Setup A-11
Exit command 2-10
Export command 2-13
exporting archived job list 2-29

F
Fiery WebSpooler

accessing 5-2
Delete Job(s) command 5-5
functions available with 5-2
Guest (view-only) privileges 5-2
Hold command 5-5
Job menu 5-4, 5-5
Operator password 5-2
overview 4-2
Print and Hold command 5-5
Print command 5-5
Process Next command 5-6
raster data 5-5
Remove Raster command 5-6
Rename command 5-5
RIP and Hold command 5-5
RIPped jobs 5-3
status bars 5-3
window 5-3

Fiery WebTools
accessing 4-3
home page 4-3
overview 4-1
passwords 4-1
Status 4-2
WebLink 4-2

WebSpooler 4-2
File menu commands 2-10
Filter 2-31
Filter command 2-13

Archive window 2-29
fonts

Adobe Type 1 3-23
deleting 3-26
displaying font list 3-26
downloading 3-22, 3-26, A-9
managing 3-25 to 3-26
PostScript 1-5
printer fonts on server 3-26
printing font list 3-7, 3-26
TrueType 3-23

Font Substitution Table 3-23

G
Guest access xv, 2-2, 2-6

H
headers

Job Log window 2-30
Queues window 2-16, 3-3

held jobs 2-19, 2-22
Help

Command WorkStation preferences 3-5
Help menu commands 2-13
Hold command 2-11, 2-25, 5-5

I
icons

Archive window 2-28
Job Log window 2-30
Print area 2-23
RIP area 2-22
Spool area 2-21

Instructions field 3-4, 3-22

J
job

active 2-19



I-3 Index
areas 2-2
canceling 3-11
defined xii
deleting 2-25
environment xiv
flow 2-17
flow diagram 2-20
flow scenarios 3-8
held 2-19
limit 2-23, 2-24
order of display 2-21
overrides 3-20, 5-6
previewing 3-15
remove raster and reRIP 2-23

job icons 5-3
Archive window 2-28
Print area 2-23
RIP area 2-22
Spool area 2-21

Job Log 2-31
calendar icons 2-30
clearing 2-31
deleting 2-31
described 2-30
displaying 5-9
exporting to a file 2-31
Filter 2-31
printing automatically 2-31
printing from the Command 

WorkStation 3-7
printing from the Control Panel 3-7
specifying a date range 2-30
updating the display 2-31
using (from Fiery WebSpooler) 5-9
viewing printed jobs 5-4

Job menu commands 2-11, 5-4, 5-5
Jobs Saved in Printed Queue 2-24
job ticket information 3-3, A-6

rearranging 2-16, 3-3

L
logging in to a server 2-5
Log in/out slider 2-15, A-7
log in/out slider 2-5
Log out command 2-12, 3-29

M
Manage Color option 2-12
Manage Fonts command 2-12, 3-25, 3-29

N
Notes fields 3-2, 3-4, 3-22

O
Open Preview command 3-15
Operator password xv, 2-6, 4-1, 5-2
Override Print Settings command 5-6

P
Page menu commands 2-12
passwords

Administrator 2-6
for Command WorkStation access 2-1
Operator 2-6, 4-1, 5-2

PDF files, downloading 3-23
performance, optimizing A-6
permissions xiv, 2-1
Photoshop, transfer functions 3-25
PostScript xii, 2-17

error 2-24
icon 2-21
RIP xii

PostScript fonts 1-5
Preferences dialog box, commands 2-10, 3-5
Preview command 2-12
previewing print jobs 3-13
Print and Hold command 2-11, 2-25, 5-5
Print area 2-2

icons 2-23
Print command 2-11, 2-13, 2-25, 5-5
Printed queue 1-10, 2-3, 2-23, 5-3
printer (job) icon 2-21
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printer fonts, see fonts
printing

Archive Log 3-7
Configuration page 3-7
defined xii
font list 1-5, 3-7
Queues log 3-7
server information pages 3-6

print jobs
previewing 3-12, 3-13
routing 2-24 to 2-27

Print Pages command 1-5, 2-10, 3-27
Command WorkStation 3-6

problems,  see troubleshooting
Process Next command 2-11, 2-25, 5-6
Properties command 2-11, 2-26, 3-20
Properties dialog box 3-20

Notes field 3-22

Q
queues 2-17
Queues window 2-7, 2-17

changing the proportions 2-19
deleting held jobs A-6
elements 2-7
spooled jobs 2-17

R
RAM 2-17
raster

data 2-22, 2-25, 5-5
icon 2-21
image 2-17
needed for DocBuilder 3-14

raster files
editing 3-14
previewing 3-12
saving 2-17
saving an edited document 3-16, 3-19

rasterizing, see RIPping
Reboot (server) command 2-12, 3-29
Refresh command 2-13

remote users A-10
Remove Raster command 2-11, 2-25, 5-6
Rename command 2-11, 2-25, 5-5
restricting access to server xiv
Revert to Default Settings command 2-13
right mouse button commands 2-24 to 2-27
RIP, defined xii
RIP and Hold command 2-11, 2-25, 5-5
RIP area 2-2, 2-22
RIPped jobs 2-3, 5-3
RIPping 2-17
Run Diagnostics command 1-9

S
server

clearing the A-10
configuring 2-4
connecting from Command 

WorkStation 2-4, 2-13
selecting another 2-13

server fonts, see fonts
Server Information slider 2-14
Server menu commands 2-12
Server Selection tabs 2-13
Setup command 2-12, 3-29
‘showpage’ after EPS files option 3-25
sliders 2-14
sorting jobs 2-29
source file 3-14
spool, defined xii
Spool area 2-2

job icons 2-21
spooled jobs 2-2

displayed in Fiery WebSpooler 5-3
icons 2-21

status bars 2-2, 2-18
animation 2-18
displaying error 2-18
Print 5-3
RIP 5-3
Spool 5-3



I-5 Index
status messages, Touch Panel Display 1-3 to 
??

Status WebTool, see Fiery WebTools
switching servers 2-13
system information 2-14
system performance A-6

T
target file 3-14
Test Page

printing A-11
printing from 

Command WorkStation 3-7
problem printing A-11

Thumbnail A
editing options 3-15
page commands 3-14
page display 3-12
window 3-14

Thumbnail A command 2-11, 2-26, 5-6
Thumbnail B

window 3-14
Thumbnail B command 2-11, 2-26, 5-6
Touch Panel Display

status messages 1-3 to ??
troubleshooting

Command WorkStation cannot connect 
to server A-7, A-8

Command WorkStation hangs A-7
general guidelines A-7
unexpected printing results A-9
users are unable to connect to the 

printer A-10

U
undo, in editing thumbnail views 2-39, 3-19
Undo command 2-12, 3-15

V
View in Helper App command 2-13
Volume column, in Archive window 2-29

W
warning

"Disk full" A-6
WebLink WebTool, see Fiery WebTools
WebSetup WebTool, see Fiery WebTools
WebSpooler,  see Fiery WebSpooler
WebTools, see Fiery WebTools
Window menu commands 2-13
window selection tabs 2-7, 2-16
workflow scenarios 3-8
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